
 

 

ThunderMax 
Throttle-by-wire (TBW) 

TMax I Tuner Tuning Manual 
 

SOFTWARE Version 2010.1.18 For 
ThunderMax High Resolution ECM 

For 2008-2010 Delphi®-Based Air Cooled Touring 
Motorcycles  
Manual V.20100520 

 
The ThunderMax EFI controller is not legal for use or installation on motor vehicles operated 
on public highways in the State of California or other States where similar emission control 
laws may apply. A 50 state ARB legal version, the ThunderMax 50, is now available.  
 
The user shall determine suitability of the product for his or her use. The user shall assume 
all risk and liability in violation of regulations and any incurred financial obligations due to 
vehicle inspections or emissions tests. 

 
Email Technical Questions to: ProductSupport@ZippersPerformance.com 

www.Thunder-Max.com  



 

 2

Section 1: Introduction 
 
 System Requirements.................................................................. 5 
 User Requirements...................................................................... 5 
 Contents of Supplied Disc............................................................ 6 
 Important Notes............................................................................ 7 
 
Section 2: Hardware and Software Installation 
 
 TMax Tuner Software Installation................................................ 9 
 TMax Tuner Software Removal................................................... 11 
 Hardware Installation Tips........................................................... 13 
 TBW Hardware Installation.......................................................... 14 
 USB Driver Installation Guide...................................................... 23 
  Windows© XP©.................................................................... 24 
  Windows© Vista©................................................................. 29 
  Windows© 7©....................................................................... 34 
 TBW Module Initialization............................................................. 38 
 
Section 3: Learning the Basics of TMax Tuner Software 
 
 TMax Tuner Software Layout....................................................... 40 
 Selecting a Base Map File from the TMax Tuner Database........ 41 
 Linking to the ThunderMax ECM.................................................. 48 
 Synchronizing TMax Tuner to the ThunderMax ECM.................. 49 
 Writing a Base Map File to the ThunderMax ECM....................... 50 
 Reading from the ThunderMax ECM........................................... 51 
 TMax Tuner File Management..................................................... 52 
 Map Notes....................................................................................53 
 Saving an Altered Map as a New File.......................................... 54 
 Map Editing with TMax Tuner...................................................... 56 
 TMax Module Control Center....................................................... 59 
 Engine Monitor Values & Gauges................................................ 61 
 Monitor Logging / Replay............................................................. 68 
 Create and Send Monitor Log Email............................................ 73 
 Tuning Maps Tree........................................................................ 78 
 Module Configuration / Basic Settings Overview......................... 81 
 Configuring the Basic Settings..................................................... 83 
 Service Data................................................................................. 88 
 Diagnostic Trouble Codes............................................................ 93 



 

 3

 Closed Loop Module Settings...................................................... 97  
 TMax Tuner Hot Key Combinations............................................. 102 
 TMax Tuner Help Section............................................................ 104 
 Prepare and Send Module Data Email......................................... 105 
 Create and Send Monitor Log Email............................................ 110 
  
 
Section 4: ThunderMax Tuning 
 
 Important Note.............................................................................. 116 
 TMax Closed Loop AutoTune...................................................... 117 
 Front Cylinder Fuel....................................................................... 118 
 Rear Cylinder Fuel....................................................................... 119 
 Idle Speed RPM (Offset) VS Engine Temp.................................. 121 
 AFR Correction VS Engine Temperature..................................... 124 
 AFR VS Engine Temperature...................................................... 126 
 Ignition Timing Maps.................................................................... 127 
 Customizing Fuel Targets............................................................ 136 
  
Section 5: Diagnostics and Troubleshooting 
 
 Basic Diagnostics Tips................................................................. 139 
 General Performance Problems................................................... 142 
 General Installation Notes............................................................ 143 
 About ThunderMax....................................................................... 144 
 
Section 6: Updates 
 
 TMax Tuner Updates Overview................................................... 146 
 Updating the TMax Tuner Software............................................. 147 
 Updating the Base Map Definitions.............................................. 149 
 Updating the Firmware in your ThunderMax ECM....................... 150 
  
Glossary of Terms................................................................. 158 
Appendix (Drop Down Menus)............................................. 162 

  



 

 4

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Section 1: 

Introduction 



 

 5

SYSTEM REQUIREMENTS 
 
TMax Tuner software package is designed to run on personal computers using 
Microsoft® Windows 2000™, Windows XP™, Windows Vista™ and Windows “7” 
™  operating systems.  The computer system must have an adequate amount of free 
space on the hard drive for proper operation. TMax Tuner is approximately 140MB 
when installed. TMax Tuner does not support Windows 98™ or earlier operating 
systems.  
 
 A high speed internet connection is required for updates to software, firmware, 
and Base Map Library updates; as well as the automated Module Data and 
Monitor Log Support Emails.  
  

USER REQUIREMENTS 
 

The TMax Tuner software requires basic computer skills to be able to effectively use the 
program and achieve your tuning goals. The operator must possess the following basic 
skills before attempting to use the software or calling Zipper’s Technical Support: 
 
 1.) Basic Windows™ Skills 

 
2.) Ability to Copy and Paste files from one folder to another 
 
3.) Maneuver through a typical Windows™ environment, storing files in 

folders and retrieving them when needed. 
 
4.) The ability to install a new piece of USB hardware, and direct Windows where 

to find the appropriate drivers.   
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CONTENTS OF SUPPLIED DISC 
 

The TMax Tuner software disc includes the following: 
 

• TMax Tuner Software 
- Complete Base Map Library 
- Complete Tuning Manual accessible through the Help 

Menu (.PDF) 
- Link to the ThunderMax website 
- “What’s New” guide  
- Automated Technical Support Options 

• Module Data Email 
• Monitor Log Email 

 
• TMax Tuner QuickStart Guide, in PDF Format.  

08-10 FL Big Twin (Touring)  
 
• AutoTune Demo File – Watch this sample video file of the AutoTune 

correcting for a 20% rich and a 20% lean condition. The video was created 
using a ThunderMax ECM with AutoTune on a load control dynamometer. 

  
• Driver files for USB communication are now supplied within the 

software. Instruction is provided for installation in the following section. 
 
If the TMax Tuner disc is not available, the TMax Tuner software with Tuning Manual 
can be downloaded from the www.Thunder-Max.com website, under the Support 
section. 
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IMPORTANT NOTES 
 

• The ThunderMax Tuning Manual contains a Glossary of Terms as well as an 
Appendix with a dialog on the menus and functions of the software. These 
features have been added to avoid any confusion over the terminology and 
functions used in TMax Tuner and in EFI tuning in general. Please refer to the 
end of this document for these valuable tools when needed.  

 

• In addition, the speedometer calibration should always be confirmed during the 
installation for your year/model motorcycle. This is critical so that your 
speedometer is calibrated and functional before road testing your new 
ThunderMax ECM. In addition, anytime a map is reloaded or a new map is 
loaded onto your ECM, the speedometer calibration needs to be set to your 
application.  

 
NOTICE to Dealers and Tuners: If you are a dealer, or an experienced 
tuner, contact your Zipper’s representative to learn about Tuner Plus software 
authorization. The Tuner Plus software is specifically designed for the 
development of base maps. 

 
  
The ThunderMax EFI Race controller is not legal for use or installation on motor 
vehicles operated on public highways, and may be restricted to closed-course 
competition use only, in the State of California and other States where similar emission 
control laws may apply. 
 
 
The user shall determine suitability of the product for his or her use.  Installation and 
use on a pollution-controlled vehicle, for highway use, constitutes tampering under the 
US EPA guidelines and can lead to substantial fines and penalties. 
 
 

See www.thunder-max.com for more information.   
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Section 2: Hardware 
and Software 
Installation 

 
Steps to Install and setup your new ThunderMax ECM: 
 

1.) Install Software (Page 9) 
2.) Install Hardware (ECM & Sensors) (Page 13) 
4.) Install USB Drivers (Page 23) 
5.) Link to the Module (Page 48) 
6.) Select and Load a Base Map (Page 41) 
7.) Verify the Speedo Cal value (Page 83) 
8.) TBW Module Initialization** (Page 38) 
  **Please note the Module Initialization procedure is 
different from the previous non-TBW ThunderMax ECMs! 

 
 Always pull the ECM fuse before disconnecting or reconnecting the 
battery! At any point if the ECM Fuse has been pulled, including during 
battery replacement, the ThunderMax ECM must be re-initialized.  
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TMAX TUNER SOFTWARE INSTALLATION 
 
To install the software onto the computer system, take the following steps: 
 
1. Exit any programs that are currently running. 
 
2. Insert the TMax Tuner Software disc into the CD-ROM drive. 
 
 

If you’ve lost your software installation disc, the newest version can always be 
downloaded from the website www.Thunder-Max.com , select the “Software” icon 
at the bottom / right of the home page. 

 
3. TMax Tuner will automatically begin the installation process; the following window 

will appear:  
 

 
 
4. The TMax Tuner Installation Wizard will now guide you through the rest of the 

installation.  
 
5. Once TMax Tuner is installed, a desktop icon named “TMax” will appear on your 

computer’s desktop. Select this new icon to open TMax Tuner.  
 

6. To ensure that you are using the latest software, after the installation is complete, 
open the software by selecting the “TMax” icon that is now on your desktop. Once 
opened, select Configure > TMax Software Update, as shown in the following 
picture. For complete instructions, see the “Updates” section in this manual.  
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Errors During Installation: 
  
Windows errors during installation are not necessarily TMax Tuner software issues. 
Please uninstall TMax Tuner software and reinsert the CD-Rom if a problem occurs 
during installation.  
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TMAX TUNER SOFTWARE REMOVAL 
 

This section describes how to fully remove the TMax Tuner software. If an error occurs 
during the installation of TMax Tuner, it may be necessary to completely remove the 
software prior to reinstalling TMax Tuner.  
 
1.) Save any custom maps and folders to your desktop.  
 
2.) Select Start > Settings > Control Panel, or Start > Control Panel, depending on 
which Windows Start Menu you use.  
 
3.) Select the Add / Remove programs option in the Control Panel. Find the “TMax 
Tuner” program, and remove it. The programs are all listed in alphabetical order, and 
the un-installation should be straightforward.  
 
4.) The “InstallShield Wizard” will start to run, and a box with three options will appear 
on your screen. Select “Remove” as shown below.  

 

 
 
5.) Follow the remaining InstallShield Wizard instructions and remove all of the TMax 
Tuner application.  
 
6.)  Restart your computer! 
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7.) Once Windows has reloaded, you need to remove a folder of information left behind 
in the Program Files directory. The folder to remove is titled “Thunder Heart”. This 
contains your Base Map library, please take the time to save any custom maps to your 
desktop now (if you didn’t in step 1), otherwise they will be deleted.  
If you have a 32-bit operating system (Windows XP or Vista), the folder to delete is 
named Thunder Heart and is found at the following location: 
 
 C:\Program Files\Thunder Heart 
 
If you have a 64-bit operating system, the folder to remove is found at the following 
location: 
 
 C:\Program Files (x86)\Thunder Heart 
 
8.) Lastly, a second folder needs to be deleted to fully remove the TMax Tuner software. 
It is also titled “Thunder Heart”.  
 
 If you have either version of Windows XP, 32 or 64 bit, the folder to remove is 
found at the following location: 
 
 C:\Documents and Settings\All Users\Shared Documents\Thunder Heart 
 
 If you have either version of Windows Vista or Windows 7, 32 or 64 bit, the folder 
to remove is found at the following location: 
 
 C:\Users\Public\Public Documents\Thunder Heart 
 
9.) You’ve now 100% removed the TMax Tuner software, and all of the files and folders 
created by it. Restart your computer and you’re ready to reinstall a new version of TMax 
Tuner. Follow the instructions to install a new version of TMax Tuner. The latest version 
of TMax Tuner can always be found on the www.Thunder-Max.com website, under the 
“Support” heading. 
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HARDWARE INSTALLATION TIPS 
 

Aftermarket exhaust systems may or may not have the 
appropriate sensor bungs welded in place. The Bosch wide 
band oxygen sensors supplied with ThunderMax TBW will fit 
08-09 OEM head pipe systems with adequate clearance, yet 
you should always make sure the sensor does not rub the 
frame, transmission or any parts of the motorcycle that could 

damage the sensor. 
 
Difficult Oxygen Sensor Removal – Work the sensor back and forth, carbon 
from the exhaust process gets caught in the threads between the oxygen sensor 
and the sensor bung; it can damage the threads if forced out. If the exhaust 
system is cold, spray carburetor cleaner, or any penetrating fluid, at the sensor 
threads to help break down the carbon build up.  
 
Wide Band Oxygen Sensor Clearance Issue – Large volume users may want 
to make a tool or “bending bar” which allows you to alter the angle of the sensor 
bungs in any  exhaust pipe that may lack proper clearance. The threads are 
18mm x 1.5 mm, which is the same as an 18mm spark plug. 
 

International Motorcycles – All international model motorcycles are equipped 
from the factory with active intake and exhaust systems. The ThunderMax does 
not support the operation of these items. No trouble codes will be present if the 

active exhaust is unplugged from the harness with the ThunderMax system. 
External devices to “trick” the ECU from creating an error code are unnecessary 

when using the ThunderMax system.  
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TBW HARDWARE INSTALLATION 
ThunderMax ECM for ’08-Up Throttle-By-Wire H-D Models ONLY 

 
Step 1. Remove seat and both side covers. 
 
Step 2. Remove the ECM fuse from the fuse box behind the left side cover. Push 
up on the bottom of the fuse box cover to remove the cover (located on the left 
side of the bike), then remove the ECM fuse from the fuse box. 
 

 
 
Step 3. Remove the narrow band sensors from the exhaust pipe, ’08-’09 models 
are located at the top of the head pipe, 2010 models (smaller) 12 mm sensors 
are located at the base of the head pipe. 

• If retaining the factory headpipes on 2010 models, 18mm bungs will 
need to be added to the headpipes.  Bungs should be located no more 
than 3-4” from the head/pipe connection (for ideal location, refer to the 
factory location on ‘07-‘09 models).  Weld-in bungs are available from 
Zipper’s (#272-200, straight; #272-202, angled).  See Video on adding 
new bungs at: www.thunder-
max.com/Support/Instructions/FuelInjectionVideos.aspx 

• Better aftermarket exhaust systems will offer o/2 sensor bungs in both 
locations.  Be sure to install 12 mm caps (Zipper’s # 272-204 / set of 2) 
when you remove the 12 mm o/2 sensors.  
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Step 4. Install the supplied wide-band sensors into the pipes; route the front 
sensor along the cross brace on the frame in front of the engine and down the 
lower frame rail on the right side of the motorcycle.  
 

 
 
Step 5. Route the rear sensor lead between transmission top cover and the 
starter, then towards the ABS caddy located under the right side cover. Tuck the 
sensor connector under the ABS caddy.  
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Step 6. Remove the factory ECM from the caddy by spreading the plastic caddy 
latches at the sides of the ECM.  Lift the ECM up and to the right to release it 
from the caddy.   
 

 
 

Step 7. Disconnect the ECM from the connector as per the following procedure:  
Depress button on socket housing of the connector; rotate locking bar until it 
reaches the full rearward position (the index pin on locking bar will engage the 
rear notch in the socket housing). 
 

 
 

Rotate locking bar fully  
towards rear of bike until 
index pin reaches notch 

Depress button
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 The connector internal latches are not fully disengaged until the locking 
bar on the connector is seated to the full rearward position to complete removal 
of the connector.  If you force the socket housing with latches partially engaged, 
it will result in damaging the connector.  Once index pin is fully seated, with 
steady yet careful attention, pull apart the connector from the factory ECM and 
remove it from the motorcycle. 
 

Step 8. With the factory ECM removed, route the AutoTune harness thru the 
opening on right side of the frame below the down tube for the seat, towards the 
ECM caddy. 
 

 
 

Step 9. If equipped with factory alarm, detach alarm antenna from ECM caddy 
clip by lifting slightly and sliding to the right of bike (do not disconnect).  
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Step 10. Locate the orange package of dielectric grease included with 
communication cable.  Spread a small amount of grease on the AutoTune 
harness plug inboard of the mounting flange to allow the plug to easily slide into 
the ThunderMax ECM, with ThunderMax logo on harness plug facing up.  Attach 
with screws provided. 
 

 
 

Step 11. Install main harness connector to ThunderMax ECM.  Before installing 
connector, lightly spread some dielectric grease on harness connector terminals, 
and on the inside lip of the connector port opening of the ECM to allow the rubber 
weather seal in the connector plug to slide into place without binding.  
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Before connecting, verify that the locking bar is in the fully open, rearward 
position (locking bar index pin is fully engaged with rear notch in the socket 
housing). 
 

 
 

 

Important Note: If the socket housing with grounding pin is not properly aligned 
during connector installation damage to the grounding pin will likely occur, which 
will require you to return the ThunderMax ECM for repair to the damaged pin.   
 

Sliding colored cam 
locks in fully open 
position towards rear of 
bike 

Fully open 
position: Index pin 
engaged with 
rearward notch
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Rotate the locking bar forward to engage the connector.  Observe that the 
colored cam locks are moving with the locking bar; proper execution will show 
both colored cam locks visible in equal amounts on the forward-facing side of the 
connector when the locking bar is in its fully seated position with the button lock 
engaged, as in the image below (do not force the locking bar).  Index pin will 
engage front notch in socket housing. 
 
 

 
 
 
Important Note: Pin and socket housing of the connector must be fully engaged 
before you rotate the locking bar to the forward position.  Forcing the locking bar 
forward before the connector is fully engaged will damage the connector and/or 
the ECM   

Fully closed position: 
Index pin engaged 
with forward notch 

Sliding colored cam 
locks in fully closed 
position towards front 
of bike 
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Step 12. Place the ThunderMax ECM into the ECM caddy.  If equipped, position 
alarm antenna as shown. 
 

 
 

Step 13. Connect the oxygen sensor harnesses to the AutoTune harness.  
Carefully wire tie the leads to the motorcycle.  Take extra care to ensure wire 
leads are safe from rubbing or chaffing on the motorcycle.  Use all supplied wire 
ties; add extra ties if needed to properly secure wiring on your installation. 
 
Step 14. Position the rear connector under the ABS caddy and attach with wire 
ties provided as shown.   
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Step 15 Position front connector above lower frame rail between engine and 
transmission.  Attach to existing harness with provided wire ties.  Inspect all 
wiring to make sure it is clear of moving parts and excessive heat. 
 

 
 
Step 16. Re-install the ECM fuse and replace the side covers. 
 
Step 17. Turn on the main power and the rocker switches, but do not start the 
engine. Leave both of these switches on for a full 20 seconds, uninterrupted.  
Turn off main power switch.  
 
You are now ready to install the USB drivers so that a connection to the 
ThunderMax ECM can be made. Be certain that you follow the appropriate 
procedure for your computer's operating system. A complete instruction set 
follows for each of the supports operating systems.   
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USB DRIVER INSTALLATION GUIDE 
 
Not all PCs will recognize “New Hardware” automatically (in this case the USB 
connection required for communicating to the ThunderMax Module). In the event 
that your PC does not initiate the New Hardware installation, the following steps 
are required. 

 
Turn the Run switch ON and the Ignition switch OFF 

 
1) Close all programs open on your PC except for TMaxI_Tuner. Minimize 

the TMaxI_Tuner software if necessary. 
 
2) From the Start menu, Right Click once on: 

a)  My Computer (XP) or  
b) Computer (Windows 7 &Vista). 
 

3) From the drop down menu that appears, Left Click once on Properties. 
  
4) A window named System Properties will appear.  

a) XP Users: Left Click once on the Hardware tab and then select Device 
Manager 

b) Windows 7 & Vista Users: Select Device Manager directly from the upper 
left of the System Properties window. 

 
5) With the Device Manager window open, switch the motorcycle’s ignition 

switch ON and watch for the “Unknown Device” or “USB Device” to appear 
(with a yellow exclamation mark beside it) in the Device Manager. 

 
6) Double Click on this “Unknown Device” . When the next window opens, 

select Update Driver, Install Driver or Re-install Driver, which ever appears. 
 
7) From this point on, use the instructions provided in the following guides 

for your specific Windows operating system to locate and select the 
TMax USB Driver for installation. The order of the initial windows that 
appear in the guides can vary from PC to PC. All possible views have been 
included for reference. 

 
Three separate instruction sections are available for installing the USB Driver 
Installation, depending on the operating system you are using.  
 

1. Windows® XP®  Page 24 
2. Windows® Vista® Page 29 
3. Windows® 7®  Page 34 
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USB Port Note: 
 
Remember to use the same USB port on your PC to connect each time to 
the ThunderMax module. To use alternate USB ports, the driver installation 
process must be repeated for each additional USB port. This is a Windows® 
issue and is not related to the TMaxI_Tuner software or USB driver. 
 

Windows® XP® USB DRIVER INSTALLATION 
 
The new TMax Tuner software for the ThunderMax Throttle by Wire EFI system 
creates a folder with the correct drivers for the USB interface. Once the USB 
cable is connected to your PC, the New Hardware Installation Wizard will prompt 
you to select an option for finding the correct driver.  
 
The following instructions will direct you to the path for locating the driver folder.  

 
Step 1. Connect the communication cable to your PC and to the ThunderMax 
module. With the Run switch and ignition switch in the “ON” position, the 
following “Found New Hardware Wizard” window will appear. Select “No, not at 
this time” and click Next to proceed. 
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Step 2. Choose “Install from a list or specific location (Advanced)” and click Next 
as shown on the next window. 

 

 
 
 

Step 3. In the next window, select the options shown below and click “Browse” to 
locate the folder that contains the USB driver.  

 
 

 
 
 

Step 4. Once the “Browse” option is selected, the following windows will appear 
where you’ll choose the path to the driver. Starting with “My Computer”, the 
path is as follows: 
 C:\Program Files \ Thunder Heart \ TMaxITuner \ TMaxUsbDriver 
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Step 4. (a) Open My Computer and 
then open Local Disk (C:) and scroll 

down to Program Files. 
 

 
 

 
(c) Open Thunder Heart and scroll 

down to TMaxITuner. 
 

 
 
 
 

(b) Open Program Files and scroll 
down to Thunder Heart. 

 
 

 
 

 
(d) Open TMaxITuner and scroll 

down to TMaxUsbDriver. 
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(e) Select TMaxUsbDriver and click OK. 
 

 
 
 
Step 5. Windows may display the following message, warning that this software 
has not passed their testing. There is no danger in using this driver. Select 
“Continue Anyway”.  
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Step 6. The following window will be displayed while the driver is installing. 
 

 
 
 

Step 7. Once the installation has completed successfully, the window below will 
appear. Select “Finish” to complete the installation. You will now be able to link to 
the ThunderMax module. 
 

 
 

If any problems are encountered, reinstall the driver by following these 
instructions – starting at Step 1. If additional assistance is needed, contact  
 

ProductSupport@ZippersPerformance.com 
 

Call (410) 579-2828 ext. 120. Monday thru Friday, 9am to 6pm EST 
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Windows® Vista® USB DRIVER INSTALLATION 

 
The new TMax Tuner software for the ThunderMax Throttle by Wire EFI system 
contains a folder with the correct drivers for the USB interface. Once the USB 
cable is connected to your PC, the Found New Hardware window will prompt you 
to select an option for finding the correct driver.  

 
The following instructions will illustrate the path for locating the driver folder.  

 
Step 1. Connect the communication cable to your PC and to the ThunderMax 
module. With the Run switch and ignition switch in the “ON” position, the 
following “Found New Hardware” window will appear. Select “Locate and install 
driver software (recommended)” to proceed. 
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Step 2. Select “Browse my computer for driver software (advanced)” as shown 
below. 

 

 
 
 
 
 
 

Step 3. In the next window select “Browse” to locate the folder that contains the 
USB driver. Be sure to check the box “Include subfolders”. 

 

 
 
 
 



 

 31 

Step 4. Once the “Browse” option is selected, the following windows will appear 
where you’ll choose the path to the driver. Starting with “Computer”, the path is 
as follows: 
C:\Program Files \ Thunder Heart \ TMaxITuner \ TMaxUsbDriver 
 
 
(a) Open Computer then open (C:) and 

scroll down to Program Files. 
 

 
 
 

(c) Open Thunder Heart and scroll 
down to TMaxITuner. 

 
 
 

 
 
 
 

 
(b) Open Program Files and scroll 

down to Thunder Heart. 
 

 
 
 
(d) Open TMaxITuner and scroll down 

to select TMaxUsbDriver and click 
OK. 
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Step 5. The following window will appear confirming the chosen path for your 
computer, to find the correct driver. Check the box to “Include subfolders”. Select 
“Next” to continue. 
 

 
 

  
 
 
 

Step 6. Windows will display the following message showing the name and 
publisher of the driver. Select “Install” to continue. 
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Step 7. The window below will appear as the driver is being installed. 

 

 
 
 

Step 8. The following window will appear once the driver is successfully installed. 
Select “Close” to complete the installation. You will now be able to link to the 
ThunderMax module.  

 

 
 

If any problems are encountered, reinstall the driver by following these 
instructions – starting at Step 1. If additional assistance is needed, contact  
 

ProductSupport@ZippersPerformance.com 
 

Call (410) 579-2828 ext. 120. Monday thru Friday, 9am to 6pm EST 
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Windows® 7® USB DRIVER INSTALLATION 
 

The new TMax Tuner software for the ThunderMax Throttle by Wire EFI system 
contains a folder with the correct drivers for the USB interface. Once the USB 
cable is connected to your PC and your bike, the hardware installation program 
will prompt you to select an option for finding the correct driver.  
 
The following instructions will direct you to the path for locating the driver folder. 

 
Step 1. Connect the communication cable to your PC and to the ThunderMax 
module. With the Run switch and ignition switch in the “ON” position, the 
following window will appear. Select “Browse my computer for driver software” to 
proceed. 
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Step 2. Once the “Browse” option is selected, the following windows will appear 
where you will choose the path to the driver. Starting with “Computer”, the path 
is as follows:  
C:\Program Files (x86) \ Thunder Heart \ TMaxITuner \ TMaxUsbDriver 

 
(a) Left Click once on the arrow head 
to the left of “Computer” to open and 

view the subfolders. 
 

 
 
 

 

(b) Under Computer, Left Click once 
to open the “(C:)” drive next. 

 
 

(c) Open “Program Files” and then 
open the “Thunder Heart” folder. 

 
 

 

(d) Under the “Thunder Heart” 
folder, find and open the 
“TMaxITuner” folder. 
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(e) Under “TMaxITuner”, find and select the “TMaxUsbDriver” folder and click 
OK as illustrated below. 

 

 
 

Step 3. The following window will appear, confirming the chosen path for your 
computer to find the correct driver. Make sure to check the box to “Include 
subfolders”. Select “Next” to continue. 
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Step 4. Windows will display the following message showing the name and 
publisher of the driver. Select “Install” to continue. 

 

 
 
Step 5. The message below will appear to verify that the driver installation was 
successful. You can now select “Close” to finish. Open TMax Tuner software and 
the software will automatically “Link” to the ThunderMax module with the bike 
turned ON. 
 

 
 
If any problems are encountered, reinstall the driver by following these 
instructions – starting at Step 1. If additional assistance is needed, contact  
 
 

ProductSupport@ZippersPerformance.com 
 

Call (410) 579-2828 ext. 120. Monday thru Friday, 9am to 6pm EST 
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TBW MODULE INITIALIZATION 
 

Please note that the Throttle by Wire  Module Initialization is different than 
the throttle cable versions of the ThunderMax ECM.  

 
Required for all new  module installations, or when interruption of 12v power 
takes place. 
 

Examples: Removal of Battery, ECM, or Maxi-Fuse 
 

1. Turn on the main power and rocker switch for 20 seconds 
uninterrupted.  

2. Cycle the main switch off and on, and then start the engine. 
3. Let the motorcycle idle on its own for 15 seconds. 
4. Cycle the ignition off and restart the motorcycle which should now 

run at the target RPM on the Idle RPM (offset) vs. Engine 
Temperature page. (Cold start would be approximately 1200 rpm). 

 

The installation is now complete for your Touring model motorcycle. Proceed to 
the TMax Tuner Software Installation Section. 
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Section 3: 

Learning the 
Basics of TMax 
Tuner software 

 
 

Although the size of the instruction manual may be intimidating, please take a 
moment to scan through the entire document to get a feel for the layout.  
 
The ThunderMax Tuning Manual is meant to be a comprehensive Reference 
Guide for any skill level user.  
 
In an effort to make the large document easier to navigate, a Table of Contents, 
Index, Glossary, and an Appendix with a “Visual Index” are included for quick 
navigation. 
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TMAX TUNER SOFTWARE LAYOUT 
 
 
 
  
 
 
 
 

MAP IN USE IN 
TMax Tuner

TUNING MAP WINDOW 
– Displays the Tuning Maps that are 
selected from the Tuning Map Tree. 
From this window you will be able to 
tune the AFR and Ignition Curves.  

TUNING 
MAPS TREE 

- This is always 
visible for quick 

map page selection 
& map toggling 
during tuning 

sessions.  

MONITOR VIEW / 
GAUGES – Live Data from 

the ThunderMax ECM – 
Customizable Display & Gauge 

Features 

DROP DOWN 
MENUS 

- These menus contain 
valuable features which 

include browsing the Base 
Map Library, saving your 
tuning work, and Read / 

Write commands for  
ECM communication.  

BASE MAP FILE ID

MODULE BASE MAP 
 ID – When Linked to the 
module, the Base Map ID is 
displayed in the Status Bar. 
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SELECTING A BASE MAP FILE FROM THE TMAX TUNER 
DATABASE 

 
The TMax Tuner EFI Map Database will help you chose the closest Base Map for your 
specific installation. To find the TMax Tuner EFI Map Database, select EFI Maps > EFI 
Map Listings / Definitions, as shown below.   
 

 
 

 
The following window should appear, with the title “Base Map Definitions”. 
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To select the closest Base Map for your engine combination, please read the following 
section on Key Elements. This will help you quickly narrow down the vast selection of 
available Base Maps and find the right one for your starting point.  
 
Base Map “Key Elements”: 
 
The reason for selecting a Base Map by “Key Elements” is to find the closest Base Map 
available for your combination, by the most critical components. The most critical 
elements for selecting a Base Map are: 

 
a) Engine Displacement - Bore & Stroke. A correct match to the engine’s stroke is 

far more important than an exact match of engine displacement. For example, 
stroke and cam timing influence pumping pressures. The correct shape of spark 
curves in the base map is what you are attempting to match. 

 
b) Throttle Body / Injector Size & Style - Currently all TBW base maps were 

developed for stock Throttle bodies and injectors.  Expansion to oversize 
injectors will be coming soon; if you are using something different please contact 
product support for map selection. 

 
c) Exhaust System Design – There is no need for concern if an exact match does 

not appear in the Base Map library. Simply select the Base Map with the closest 
style of exhaust system. Even if brand is not an option, choosing the closest style 
will yield excellent results. Group your exhaust system in one of the following 
three categories:  

 
i. Factory Head Pipe with Crossover – Dual exhaust systems with a 

cross over pipe that connects the front and rear exhaust pipes. 
Typically kept with slip on mufflers.  

ii. Dual Exhaust – 100% separate exhaust pipes, short or long.  
iii. 2 into 1 Collector – Both head pipes converge into one collector. 
iv. Comments about use of Catalysts as mentioned in the exh pipe 

map notes  
 
The AutoTune system allows you to choose a Base Map that isn’t a perfect match and 
still have excellent results. The closer that the Base Map is to your combination, the 
faster the system will achieve the desired AFR Targets. This simply means less time to 
establish and maintain a great tune. Even if your combination isn’t listed, select the 
closest match and let the AutoTune start creating your custom Base Map while you ride. 
Use the Auto Map feature to create your custom base map.  
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Base Map File Browsing / Selection: 
 
Now that you have the Base Map Definition window open, you may begin narrowing 
down the list of maps for your application. To sort the map files by a particular key 
element, click on the column heading. 
 
Select “Engine Type”, the Base Map Definitions will be sorted by the engine 
displacement, which is the first Key Element you need to match to your combination. All 
of the column headings can be used for sorting purposes.  

 

 
 
 
To filter the TMax Tuner EFI Maps Database, RIGHT click on the engine displacement 
that matches your engine, as described in the Key Elements section. Right clicking will 
hide all other options for that particular category. If you right click on “96 c.i”, all of the 
other options are temporarily hidden, as shown in the following picture.  

 

 
 

Notice that the “Clear Filters” button is now selectable. If you want to go back to the 
complete library listing, select the “Clear Filters” button and you will start over with all 
Base Map Files displayed.  
 
Now that an engine displacement has been selected, and all the other maps are hidden, 
move to the second Key Element, Throttle Body / Injectors. For a 96 ci engine, all of the 
available Base Map choices were created with factory installed throttle bodies and 25o 

Column Heading 
– Click here to 
sort by Engine 
Displacement

Right Click to hide 
ALL other Base 

Maps, except 96 ci 
Engines



 

 44 

injectors. Since there aren’t any additional options, move on to the third Key Element, 
which is the exhaust system. If you have a factory head pipe with slip-on mufflers, right 
click on “Stock HD FL Head pipe” to hide all other exhaust options, as shown below.  
 

 
 

All 3 Key Elements have now been satisfied, the engine displacement, throttle body / 
injectors, and the exhaust system. As the picture above shows, there are still 3 choices 
for a Base Map for your engine combination. The ThunderMax with AutoTune system 
has more than enough resolution to use any of these Base Maps to correctly tune your 
engine. Remember, Base Maps are starting points that the AutoTune system corrects 
for your specific engine and riding conditions.  
 
Continue selecting options until you have the library narrowed down to the fewest 
number of maps as possible. Several options may still remain; always select the Base 
Map with the latest build date. Double left click to select this Base Map. 

 

 
 

If you’re still unsure of which Base Map to select, please email the 
specifications of your Key Elements to 
ProductSupport@ZippersPerformance.com. Please title the email “Base Map 
Selection” for a faster response.  

 
 

Slide to the right to reveal 
the other components 
used during the Base 

Map creation 



 

 45 

Loading the Base Map File: 
 
Now that you’ve selected the appropriate Base Map file for your engine combination, 
you need to load this selected Base Map into TMax Tuner. Once the Base Map you’ve 
chosen has been double Left clicked, the following window will appear, titled “Base Map 
Name Encoding.” 
 

 
 
Select the “Load Base Map” button on the “Base Map Name Encoding” window, as 
shown above. Once selected, TMax Tuner will load this Base Map and return to the Air / 
Fuel Ratio vs. TPS page.  
 
Now that the map is loaded into the TMax Tuner software; you must write the map to 
your ThunderMax ECM. If you are installing a new Base Map in an already used 
ThunderMax ECM, please remember to clear all of the offsets from the system’s 
previous Base Map, and double check the Basic Settings.  
 

Proceed forward with the Tuning Manual, remembering that a new base 
map file will require the ECM to be initialized, the Basic Settings need to 
be checked, and all offsets must be cleared from the previous map.  

Loading the 
map into TMax 

Tuner does 
not Write the 
map onto the 

ECM. 
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Base Map Definitions Updates: 
 
To ensure that you have the complete, and up-to-date, Base Map Library, select the 
“Check Internet for Updates” button on the “Base Map Name Encoding” window, as 
shown below.  

 

 
 
 

Base Map Updates: 
 

TMax Tuner now downloads all of the new base map files when you update the Base 
Map library. Previously only the Base Map library list was updated, so if you selected a 
map from an updated library list, TMax Tuner needed to download the map from the 
internet before you could proceed. Now the Base Map files are all downloaded during 
the update, which simply means that the newest Base Maps are always stored on your 
computer.   
 
The following window will appear if any new maps exist in the Internet database, but do 
NOT exist on your system: 
 

 
 

You will be provided an ESTIMATE of the download time required to perform this task. 
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It is simply good practice to update the definition file when searching for a new Base 
Map file. Not only are new maps constantly being created, but the older Base Maps are 
updated occasionally as well. Once updated, you may proceed with selecting an 
appropriate Base Map for the current engine combination you are working with. When 
the Base Map Library is up to date, the following window will appear: 
 

 
 
If you are satisfied with the operation of your current Base Map, chances are a new 
Base Map will not make a significant difference to the operation of the motorcycle. 
Updated maps could contain spark curve or fuel management changes, or even fuel 
economy strategies.  
 

If you are unsure how to select a map after reading this section, contact 
a Zipper’s representative for assistance. This step is critical in the 
optimization of the power, economy, and overall drive-ability of your 
motorcycle. Zipper’s Performance Products is committed to customer 
satisfaction, so please do not hesitate to ask for assistance. 
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LINKING TO THE THUNDERMAX ECM 
 
1.  Install the communication cable from the PC to ECM.  

 
NOTE: Make certain that the communication cable is not resting on or near 
any part of the motorcycle that generates heat.  
 

2. Turn the ignition on, making sure the OFF/ RUN switch is in the “Run” position, but do 

not start the engine. The software will automatically  to the ECM when power 
is detected. The red background will turn green when successfully linked, indicating that 
the PC and ECM are now ready to begin communication (see picture below). 
 

 
 

 
NOTE: NEVER attempt to load or reload a complete map with the engine 
running. 
 

 
If you are NOT successful in linking to the system for the first time, please double check 
everything on the following list to verify your setup. TMax Tuner automatically finds the 
proper Com Port to use, so linking issues are generally rare and unrelated to the 
software itself. 
 

a.) Are the cables properly installed from the ECM to the USB port on the 
computer? Remove the cables and reinstall to be certain the connection is 
solid.  

b.) Does the system have power? Is the ignition in the “ON” position with the 
OFF / RUN rocker switch in the “Run” Position?  

c.) Is the driver installed correctly for the ThunderMax system? See the USBSER 
Driver Installation Guide in the Help section for details. 

d.) Try a different USB port on your computer. Remove / re-insert cable.  
e.) Disable your Anti-Virus Software to see if a conflict exists.  
f.) If unable to solve the problem, please contact the Zipper’s Technical Support 

team for assistance.  
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SYNCHRONIZING TMAX TUNER TO THE THUNDERMAX ECM  
  
Once you have successfully linked to the ThunderMax ECM, select the Monitor button 
to activate live gauge readings. A window will appear that alerts you of any differences 
between the map that’s currently opened in TMax Tuner, and the map that’s loaded in 
the ThunderMax ECM. Select “Yes” to synchronize (read) the map and allow 
monitoring. 

 

 
 
If you select “Yes,” TMax Tuner will prompt you to save the map currently open in the 
software.  
 

 
 
This notice is to help prevent changes or edits from being made to an OPEN MAP 
which may NOT be intentional. The notice will appear when the program is closed or 
when a new map is loaded. It is highly recommended to save your map before closing 
the program or loading another map by selecting File > Save as and creating a 
dedicated folder for your maps. Renaming the file by changing the date code (last 6 
digits) will help you track your work.  
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WRITING A BASE MAP FILE TO THE THUNDERMAX ECM 
 
Select File > WRITE Module Maps and Settings, as shown in the following picture.  
 

 
 
 
After the transfer bar completes, the map is loaded into the module. Re-initialize the 
system according to instructions.  
 
 
 

DO NOT START THE ENGINE or move the throttle 
during the initialization process. In addition, the monitor 
gauges still need to be set to display the parameters 
that you wish to watch during the run session. 
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READING FROM THE THUNDERMAX ECM 
 
To read a map that was previously installed on a ThunderMax ECM, select File > READ 
Module Maps and Settings, as shown in the following picture.  
 

 
 

This will start a Progress Bar window while the settings in the onboard ECM are being 
brought to the screen. Wait until the Progress Bar is complete before attempting to work 
in TMax Tuner. This may take 15-30 seconds depending on the speed of your 
computer.  

 
Once READ, the ECM’s current map and settings will be displayed in TMax Tuner. The 
Air/Fuel vs. TPS window automatically opens first.  

 
IMPORTANT NOTE: Any time you are connected (linked and powered 
up) to the module, any changes you make are LIVE and affect the 
system settings and maps immediately.  You will have effectively 
modified the original base map in the module, but not the base map file 
that is saved on your hard drive or in the Base Map data base.   

 
This modified map with changes should be saved to your hard drive as a renamed 
version of the original base map file. If you unlink from the system without saving the 
changes to your modified maps folder, you can access/view those changes by re-linking 
to the module and selecting File > READ Module Maps and Settings. 
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TMAX TUNER FILE MANAGEMENT 
 
Proper file management is crucial to the identification and organization of data. In order 
to access maps with unique changes and special tuning work, naming and saving maps 
is critical. Although this is a relatively simple procedure, if it is not addressed and 
understood before the tuning process is begun, loss of maps with valuable tuning time 
is inevitable.  
 
TMax Tuner uses “Base Map” files that save the fuel curves, ignition curves, even the 
basic settings for the Speedometer Calibration, idle RPM and the Rev limiter. All of this 
data is stored in one file which makes management of the maps relatively simple. All 
TMax Tuner map files have a file extension of “.slk.” Each map file name is made up of 
16 characters, the first 10 letters designate the original engine combination that the map 
was made for, and the last six numbers refer to the date on which it was created, 
updated, or last modified.  
 
It is imperative that as changes are made to the map file, the file is renamed and saved. 
Zipper’s retains all of the original map files if you lose or misplace the map given to you 
at the time of the sale. However when changes are made to a map to tune the ECM 
to a specific application, it is up to the user to save this edited base map file.  
 
You can create subfolders inside the “TMaxI” maps folder to save each combination that 
is mapped with TMax Tuner. The more TMax Tuner map files that you save; the easier 
it will be to map different combinations in the future. Even though every engine is 
different, if you build a library of map files in addition to the TMax Tuner Map Database, 
chances are good that any combination that arrives at your doorstep can be mapped by 
altering the closest match.   
 
As more changes are implemented, do not delete the previous modified base map file; 
simply create another map file with an updated date / name. This can save an 
Enormous amount of time if changes are made and the tune goes in the wrong 
direction. It will always be easier to reload a known good running map than try to 
manipulate a modified map back to a previous condition.  
 
If a base map is edited and not saved, TMax Tuner will prompt you to save the map 
when closing the program, as shown below. If the map has been renamed, the edits will 
be saved to the renamed map. If the map was opened from “Base Map Definitions” or 
from the “TMaxI” folder in Basemaps, the edits will NOT be saved to the original base 
map in your TMax Tuner library. Use caution when prompted to save the base map.  
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MAP NOTES 
 
A “Map Notes” function is available for keeping track of tuning changes directly in the 
map. Select EFI Maps > Map Notes as shown below, to reveal the “Map Notes” 
window. In this window you have a virtual “notepad” to record your map changes and 
test results. This is a great way of logging the changes made to the Base Map File or 
values changed in the Module Configuration. Map File Notes entries are only saved 
when the map is saved! 
 

 
 

 
 
Zipper’s is continually increasing and improving the TMax Tuner Map Database to aide 
in tuning the vast array of engine combinations in the marketplace today. It is virtually 
impossible to create perfect matches for every combination of custom pipes, throttle 
bodies, or engine modifications, which is the basis of why the AutoTune system was 
created. In most cases, the ThunderMax will AutoTune for the exact component 
variations without your intervention once given a relatively close base map.  
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SAVING AN ALTERED MAP AS A NEW FILE 
 
Now that you know how to load an existing map file, it is very important to know how to 
save the base map in a new folder. In this new folder all modified versions of the base 
map file can be stored for future use. This will allow you to make changes to your base 
map file and still have the ability to reload the original base map file if the new base map 
file does not operate as well as the provided base map file.  
 
To save the loaded map as a new file, select File > Save As… as shown in the picture 
below.  

 

 
 
The following “Save As” window will appear: 
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The folder that is opened by default is called “TMaxI.” The easiest way to store and 
manage the new modified maps is by creating a new folder titled “My TMax Basemaps” 
in this “TMaxI” directory. To do this, select the “New Folder” button as shown below, 
circled in red. A new folder will appear, simply type “My TMax Basemaps” and hit the 
Enter button on the keyboard.  

 

 
 
Select the new folder that was created and type the base map file name that you have 
loaded. For example: if “HCSSSGSAAN011110.slk” is loaded into TMax Tuner, enter 
the Base map file name in the “File Name:” box and select the “Save” button.  

 

 
 
A duplicate base map file will be created in this folder. As you make changes to the 
tuning blocks and test the outcomes, save the tested base map files in this same 
location. The last six digits of the file name should be changed to the date that the 
map file was modified, (MM, DD, YY). This will allow you to make multiple changes to 
the base map file’s tune-up, while retaining your previous tune-ups. By maintaining the 
original first 10 digits of the base map file name, the map can still be identified by the 
name to reveal the engine combination that the base map file was originally intended 
for.  



 

 56 

MAP EDITING WITH TMAX TUNER  
 

 
 
Map Editing in TMax Tuner software is based on fuel offsets created by the AutoTune 
system, and reading and writing maps in the ThunderMax ECM. After describing the 
individual functions, instructions will follow in this section that explains how to use this 
as an “Accelerated Auto Map Generator”.  
 
Read “Learned Fuel Adjustments (CLP OFFSET)”:   
 
The Read Learned Fuel Adjustment function downloads all of the Base Map Learned 
Fuel Offsets, generated by the AutoTune system, into the TMax Tuner software.  This 
function allows the user or tuner to then see the offsets that the AutoTune has 
generated from the base map, to meet the specified Target AFR.   
 
AutoMap (Write “Learned Fuel Adjustments (CLP OFFSET)”):  
 
Converts the fuel flow (learned) offsets to base map points- Resets the Auto Tune range 
for extended learning.   
 
Clear “Learned Fuel Adjustments (CLP OFFSET)”:  
 
The “Clear Learned Fuel Adjustments” option ERASES ALL of the offsets learned by 
the AutoTune system from the ThunderMax ECM. This option is necessary when 
changing Base Map files in the ThunderMax ECM, but can be useful in the following 
scenarios: 
 

1.) Sensor Problem – After replacing the bad sensor, clear the errant offsets that 
were created.  

2.) Air Leak - After repairing an induction side air leak, clear the offsets that were 
created. 
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READ Module Maps and Settings:  
 
Reads the Module Base Map from the ThunderMax ECM and loads it into the TMax 
Tuner software.  
 
WRITE Module Maps and Settings:   
 
Uploads and synchronizes the selected base map calibration from the TMax Tuner 
software to the ThunderMax ECM. 
 
Undo Edits: 
 
Returns adjusted map points back to the yellow markers (historic map points).  
 
Reset Undo (Yellow Markers):  
 
Resets all yellow markers (historic map points) in the map to mark the current map 
points. 
 
Tuning Experience Benefits 
 
If your engine combination does not closely match the available base maps, or your 
engine performance or fuel mileage is lacking, the Map Editing functions will easily  
benefit you. Variances that can be easily handled by the Accelerated Auto Map to 
correct the following: 
 

• Different Exhaust Pipes 
• Injector Flow Rates, Spray Angles, or Throttle Body design 
• Fuel Pressure – the factory service manual says 7 lbs of variance of Fuel 

Pressure is acceptable! 
• Different cams 
• Various Air Filter kits 

 
The performance of your engine, as well as the fuel mileage, should always be excellent 
with the ThunderMax with AutoTune. If you are not happy with the performance or are 
experiencing excessive fuel consumption, use the TMax Control Center for advice to 
correct these issues. The AutoTune system creates “offset points” dynamically as you 
ride. Using these Read / Write functions will apply the offset points to the “Entire Map 
Point Set” as needed. This takes your learned points, and creates a custom Base 
Map for your application.  
 
This powerful new feature provides cutting edge map tuning at your disposal. Virtually 
any engine or exhaust pipe combination can be improved with the use of the AutoTune 
system and these Map Editing functions. The following simple procedure explains how 
to use these functions to bring almost any engine combination into tune by using the 
Auto Map generator function.  
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Accelerated Auto Map Procedure:  
 

1.) Link to the module, Select Map Editing > Read Module Maps and Settings. 
 
2.) Select TMax Control Center from the tool bar.  

 
3.) Review the information listed under the Auto Tune Checkup to evaluate the 

progress of the “Learned Fuel Adjustments”  
 

4.) If advised, select Run AutoMap. The Learned Fuel Adjustments will be written to 
become the new map points. 

 
5.) Do not disturb this process! TMax Tuner is converting the Learned Fuel 

Offsets into Base Map Fuel Points. 
 

6.) Once the process is complete, the base map has been successfully revised and 
smoothed; now simply test the results.  

 
7.) If an improvement was made, but the tuning is not complete, ride the motorcycle 

to generate additional fuel offsets, and repeat this process. It may take a few 
cycles of this Accelerated Auto Map Procedure to fully create a custom Base 
Map for your application. At least 2 cycles of riding and writing the offsets is 
recommended for any application.  
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TMAX MODULE CONTROL CENTER 
New Features with the TMax Control Center 

 

 
  

The TMax Control Center is a one stop source for information on the most critical 
system functions. A unique element of this feature is the feedback provided on the state 
of your tune via the Auto Tune Checkup. After logging some time on the ThunderMax 
system, this feature will list a progress report and advice on performing any steps 
needed to optimize performance. If fuel adjustments are approaching the maximum 
learning limit, there is now detection to quickly review the condition of the tune of each 
engine. Information and advice are provided on the following critical system functions: 
 
• Progress of the Auto-Tune system fuel adjustments. 
• Engine RPM and Temperature Logs. 
• Engine Diagnostic Codes. 
• Auto-Tune Settings. 
• Basic Module Settings. 
 
The AutoMap (Map Editing) function can now be executed within the TMax Control 
Center by selecting the Run AutoMap button. When Using the AutoMap function, all 
fuel base map points are reset and smoothed to the learned offset values. The AutoMap 
feature refines the base map fuel calibration based on “Learned Parameters” 
established during engine run cycles. Applying learned map refinements allows the 
system to continue making further refinements as the engine is operated in varying 
ambient conditions. 
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Fuel Adjustment Offset Summary 
 

 
 
The Fuel Adjustment Offset Summary window appears when the Details button is 
selected under the Auto-Tune Checkup section. Here you’ll find details of the number of 
adjusted points, averages, increased, decreased, percentage ranges, and descriptions 
of the meaning of these values. Fuel adjustments in the 15-20% range are approaching 
the maximum offset which could influence fuel mileage or limit the engines power 
output. AutoMap will quickly correct these conditions. 
 
The AutoMap feature will likely improve the performance of most any ThunderMax 
system in use.  We strongly encourage feedback from all to report their experience with 
this new feature and any other products or software.  
 
The Product Support team stands ready to assist our customers with any questions or 
concerns and we welcome comments and suggestions on how to improve your 
experience. productsupport@zippersprefomance.com 
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ENGINE MONITOR VALUES & GAUGES 
 

The “Engine Monitor” function is a helpful tool to use while performing live tuning, and to 
keep a watchful eye on the vital engine data while amending maps. In addition, it is very 
helpful to diagnose problems or to make adjustments with sensors or components. This 
will allow you to view all of the important sensor values on the same screen as the map 
page while the engine is running and being tuned. 
 

 
NOTE: The Engine Monitor Values will only be Live when the ECM is 
powered up, linked to the computer, and the “Monitor” button selected.  
 

To display the monitor data from the ECM, click the  button, which is next 

to the  button on the toolbar.  The “Monitor” button will turn green when 
active, exactly like the “Link” button does.  

 

 
 

The engine monitor buttons and values are always to the right of the “Tuning Maps” 
tree. The monitor values will always be in this location. If a map page window is 
maximized, these values will be hidden behind the window. To toggle between the 
“Tuning Map” and “Monitor View”, select “Window > Monitor View.” 
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To select the values that you wish to monitor in the “Monitor View” portion of the TMax 
Tuner layout, select Monitoring > Monitor Setup… as shown below.  

 

 
 

The following screen will appear, with check boxes beside each Monitored Value. Each 
engine monitor with a check mark will be displayed on the “Monitor Views” section of the 
TMax Tuner layout. To return to the Monitor Gauge view, select Monitoring > Monitor 
Setup again. The “Monitor Setup…” button will toggle between the Monitor Gauge / 
Setup windows.  
 

 
 
Please note that when the “Monitor Setup…” is selected, TMax Tuner automatically 
terminates the current Monitor session. Selecting “Monitor Setup…” should be 
performed prior to starting a live tuning session. Zipper’s recommends that you keep all 
of the values selected for the Monitor View section; this will allow you to set up the  
 
Monitor Gauges without toggling back and forth between the Monitor View section and 
the “Monitor Setup…”  
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Default Monitor Gauges: 
 
The most commonly used Monitor Gauges now automatically appear when monitoring, 
without having to specifically tell TMax Tuner to display these individual gauges. The 
following gauges will now appear by default when “Monitoring” is selected: 
 
 Engine Speed 
 Engine Head Temperature 
 Battery Voltage 
 IAC Position 
 AFR Front 
 AFR Rear 
 AFR Target 
 

 
 
You can always activate additional gauges as needed, or remove the default gauges if 
necessary. Keeping a watchful eye on these default gauges is recommended anytime 
the motorcycle is running and you’re linked to the ThunderMax ECM.  
 
The following section will explain how to activate, and de-activate monitor gauges in 
general. The engine monitoring values can be customized into individual gauges to 
highlight the parameters that you wish to monitor during the run session. To create and 
customize the gauges, select the name of the gauge (individually) that you wish to 
monitor.  
 

 
 
More than one gauge can be open at once; however each parameter must be selected 
individually. For example, if the “Engine Head Temp” button is selected, the following 
window will appear.  
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In this dialog, select the box next to the “Activate Gauge Display” gauge option. 
Checking this option tells TMax Tuner that you want the gauge values shown for easy 
viewing during the tuning process.  
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This will tell the gauge to appear whenever monitoring is in effect OR whenever gauges 
are toggled from the menu bar, as shown below. To toggle the visibility of the gauges, 
select Monitoring > Show Gauges. 

 

 
 
Also within the Monitor Display Setup dialog you can custom design gauges to 
represent low, normal and high ranges as desired, and set each range of the individual 
gauges you want to monitor.  Colors will read on your computer monitor (yellow, green 
and red respectively) as set by your parameters. 
 

 
 
The “Operational Ranges” parameters are entered as values based on the “normal” 
units of the selected monitor.  In this case “degrees F” are the units and the low range 
(yellow) is from -40 to 87.875 degrees F and the high range (red) will be anything above 
343.625 degrees F.  That leaves the green range (which is listed as white) as 87-343 
degrees F.  If you enter invalid entries, the software will make corrections and let you 
verify the changes.  This occurs when you OK the dialog box.  
 
The following monitor gauge represents what you have just created. When the 
temperature rises above the 343o limit, the gauge turns from Green to Red and begins 
flashing, to immediately bring your attention to the temperature of the cylinder head. 
Although TMax Tuner cannot prevent an engine from overheating, if used properly, the 
Monitor Gauge function will alert you well in advance that the temperature is too high to 
continue operation.  
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The next portion of the Monitor Display Setup is the Gauge Value Limits section. From 
here you will set the minimum and maximum ranges the gauge will represent. 
 

 
 
In this case the gauge limits are from -40 – 471.5 degrees F. 
 
More appropriate limits and ranges may be desired. Experiment with these values to 
see how they affect the gauges.  All Gauge Value Limits, gauge visibility and the gauge 
location are saved upon exit of the TMax Tuner program. 
 
The final section of the Monitor Display Setup is called “Gauge Display Dampening”. 
You will notice after using TMax Tuner for the first time that some of the gauges are 
constantly changing or varying between a series of values. This is in part due to the 
sensitivity and sampling rate of the sensors used in the ThunderMax system. 
ThunderMax samples and records data much faster than the human eye can process 
the changes. To slow down the data that is being displayed, a timeframe can be 
imposed on the gauge to limit the refresh rate by up to two seconds. By default the 
Gauges are set to ½ second dampening. Experiment with these values to find the 
proper dampening for your application and preference.  
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Once the option of “Activate Gauge Display” is selected and the gauge limits are set, 
one of two things will now happen. The “Engine Head Temp” box will appear on your 
screen as shown in the following picture, if the “Link” and “Monitor” buttons have 
been activated (green background).  

 

 
 
If the monitor gauges do not appear, select Monitoring > Show Gauges as previously 
described.  Drag the gauges around your screen to customize the gauge location to 
your preferences. To drag a Monitor Gauge, move your mouse arrow over the blue bar 
of the Monitor Gauge and then hold down the left mouse button to drag the monitor 
gauge to a convenient location. 
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MONITOR LOGGING / REPLAY 
The monitor logging capability allows you to record data during tuning and riding 
sessions. This feature is extremely useful for reviewing the stability of your AFRs or 
when troubleshooting a tuning issue, an electrical problem (faulty sensor), or a 
mechanical problem like a clogged fuel filter. The Monitor Logging feature will record all 
of the vital engine operation data, and allow you to save and replay the operating 
session. This data can be emailed to Zipper’s Technical Support for analysis and 
recommendations for tuning issues. In a Closed Loop application, with the AutoTune 
system installed, you can replay the front and rear cylinder AFRs as well as the 
corresponding throttle positions.  
 
Sending a monitor log session to the Product Support team is the same as having 
a technician next to your motorcycle, reviewing the monitor gauge readings and 
analyzing the results.  
 
How to Manually Create and Save a Monitor Log 
 

1. Update your TMax Tuner software to the latest version from Configure > TMax 
Software Update. Internet connection is needed for this update. 

 
2. Establish a Link to the ThunderMax ECM through TMax Tuner.  

a. Install the communications cable between the ThunderMax ECM and your 
computer. 

 
b. Move the handlebar 

switch to the RUN 
position and turn the 
Ignition ON.  

 
 
 
c. Open TMax Tuner and select the red “Link” button which will turn green. 
 

 
3. Select “READ Module Maps and Settings” from the “File” menu. Learned Fuel 

Adjustments will be read automatically when using the latest software. 
 

4. Select the  button, which will turn from red to green .  
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5. If your pre-selected Monitor Gauges did not appear, select Monitoring > Show 
Gauges to activate. 

 
6. Now select Monitoring > Monitor Logging as shown below.  

 
 

At this time the Monitor Logging session will begin, with or without the engine running. 
The following window will appear when the Monitor Logging session has begun. 
 

 
 
OPTIONAL: To check the Throttle Position Sensor function, twist the throttle wide open 
and then closed one time BEFORE starting the engine. 
 

7. Start the engine and allow the head temperature to rise to a normal operating 
temperature (260-285° F), and observe the gauge activity. All data is being 
logged during engine operation. Proceed with Monitor Logging as long as 
necessary to record any activity for evaluation. 

 
 
 

This may require a loaded road test or dyno pull to reveal the tuning 
problem. Road testing may not be practical unless you own a laptop and 
have adequate means of attaching and protecting the computer while the 
motorcycle is in operation. Please use caution and good sense when 
determining if a road test can be safely performed.  

 
8. Once you are complete with your Monitor Logging session, select “Stop Monitor 

Logging” or select the  button again to close the monitor session. 
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How to Replay a Monitor Log: 
 

1.) Now that TMax Tuner has created a Monitor Log file, you can open it for viewing 
by selecting Monitoring > Monitor Replay, as shown below.  

 
 

2.) The following window entitled “Monitor Playback Control” will appear.  
 

 
 

3.) Select the “Log File” button, which is circled in red above, and select the 
appropriate monitor log file.  

 
4.) By default the Monitor Logs are saved by the date and time that the log started; 

which ensures that none of your previous monitor logs are accidentally 
overwritten. The following window will appear: 
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:  
Choose the appropriate Log File and select the “Open” button. 

 
5.)  Select the “Play Forward” Button, as shown below, and the monitor replay will 

begin in the background. Drag the “Monitor Playback Control” window out of the 
way of the map window and the monitor gauges.  

 

 
 

Since TMax Tuner is replaying the monitor log like a video, you may fast forward or 
rewind the monitor session by dragging the slider or using the arrow buttons. A “Replay 
Speed Control” slider allows you to control the speed at which the log is replayed.    
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Where are my Monitor Logs saved? 
 

The monitor logs are stored in the “All Users or Public” folder. A folder titled 
“ThunderHeart” has been created in this directory. In this instance, TMax Tuner saved 
the Monitor Log titled “WednesdayJanuary132010114128.txt” in the following location 
on my computer:  
                                                                                        
For Windows XP 
C:\Documents and Settings\All Users\Shared Documents\Thunder 
Heart\TMaxITuner \MonitorLogs\WednesdayJanuary132010114128.txt.  
 
For Windows Vista & “7”  
C:\Users\Public\Public Documents\Thunder Heart\ TMaxITuner \ 
MonitorLogs\WednesdayJanuary132010114128.txt. 
 

How do I send a Monitor Log to Zipper’s for Review?  
 

A simple method of creating monitor logs has been added to help the majority of TMax 
Tuner software users. Now you can create a monitor log and TMax Tuner will 
automatically package the file in an email with the Base Map from your module.  
Simply select Help > Create and Send, Monitor Log Email, and follow the instructions 
in the next section.  
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CREATE AND SEND MONITOR LOG EMAIL 
 

The second major support tool that has been added to TMax Tuner is similar in 
operation to the “Prepare and Send Module Data” function. However, this function will 
allow you to create and save a monitor log session and TMax Tuner will email the data 
to Product Support for you providing that you use an email client such as MS Outlook or 
Outlook Express. The email program must be open to complete the send function.  
 
This function will only work if an email client is loaded onto your computer. Web- based 
email users can duplicate this entire process and submit monitor logs for review, 
however additional steps are required. Please see instructions on how to manually 
email a monitor log to the Product Support Team.  
 
To access the function, select Help > Create and Send, Monitor Log Email.   
 

 
 
The following box will appear:  
 

 
 
Select “Yes” to continue in creating a Monitor Log, and emailing it to Product Support. If 
“Yes” is selected, the following box will appear: 
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Once activated, the monitor logging session begins. Use the monitor logging feature to 
record oddities in the operation of the ThunderMax ECM. The combination of a monitor 
log and a module data email Base Map file with Learned Fuel Offsets, submitted to the 
Product Support Team, is almost as good as having a ThunderMax technician evaluate 
the operation of your motorcycle first hand.  
 
Once the logging session is complete, the following window will appear:  
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At a minimum, fill in your name, phone number, the basic information on your 
motorcycle, and the nature of the issue in this window. The more information that’s 
given up front, the faster the Product Support Team can fulfill your request for 
assistance. Help us help you!  
 
Once you’ve filled in as much information as possible, select the “OK” button on the 
“Support Email Creation” window. The following box may appear: 
 

 
 
This is a warning that was generated by Microsoft Outlook, due to TMax Tuner creating 
and attempting to send an email on its own. If you choose “No”, a box will appear that 
simply says “Failed.” If you choose “yes” and allow TMax Tuner to send an email for 
you, the following will appear if successfully sent. To ensure that the email was 
successfully sent, double check the contents of your “Sent Items” folder in Outlook.  
 

 
 
If you do not have an email client loaded on your computer, this function cannot send 
any emails. The following error will appear if a supported email client is not found;  
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Web-Based Email:  
If you do not have an email client loaded on your computer, you can still send a Monitor 
log or a map for review through any web-based email. However, a few additional steps 
are required. The monitor log files are saved in the following directory: 
For Windows XP 
C:\Documents and Settings\All Users\Shared Documents\Thunder 
Heart\ TMaxI_Tuner \Monitor Logs\ WednesdayJanuary132010114128.txt.  
 
For Windows Vista  
C:\Users\Public\Public Documents\Thunder Heart\ TMaxI_Tuner\Monitor Logs\ 
WednesdayJanuary132010114128.txt. 
 
The location of the monitor log is important if you need to manually submit your Monitor 
Log to Zipper’s Product Support for review. When submitting a monitor log for review, 
please include the following items: 
 

1.) The Monitor Log File; only the .txt file is needed. 
2.) The Module Map File installed in your ThunderMax ECM. You must save 

the map from your ThunderMax ECM, and email the .SLK map file with the 
Monitor Log File. The AutoTune offsets and learned data that are stored in 
the map file must accompany the .txt file for proper monitor log review.  

3.) The Version Number of the TMax Tuner software that you are using.  
To find the TMax Tuner version, select Help > About TMax Tuner…, as shown below.  
 

      
 
 

 



 

 77 

In the window below you’ll find the software version as well as the firmware version in 
your module. 
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TUNING MAPS TREE 
 

  
 
 
 
 
 
 

The Tuning Maps Tree is located on the 
far left of the TMax Tuner layout, and is 
used to access different tuning and 
configuration pages of the software. 
Clicking on each of these tree titles 
opens a window to allow editing of a 
particular function: 
 
Front Cylinder Fuel: 
All Fuel Flow map pages are now 
displayed for viewing.  These map 
pages show the Front Fuelflow vs. 
TPS curves for each RPM page. All fuel 
offsets made by the AutoTune system 
can be viewed on these pages.   

 
Rear Cylinder Fuel: 
These map pages show the Rear 
Cylinder Trim vs. TPS rpm map pages. 
These map pages will contain the 
AutoTune fuel offsets, once they are 
read from the ECM. 
 

Idle Curves- The Idle Speed Rpm 
(Offset) vs. Engine Temperature map 
page is  used to control the Idle Speed 
at specific engine temperatures, for 
example note the difference between 
idle speed  during a cold start warm-up 
period vs. normal engine operational 
temperature 
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Air Fuel Ratio Curves: 
 

1.) The AFR Correction vs. Engine Temperature map page allows the adjustment 
of the AFR correction at specific operating temperatures.  

2.) The AFR vs. Engine Temperature map page is only for Closed Loop Auto-Tune 
applications. This gives the Auto-Tune system AFR targets for specific operating 
temperatures.  

 

Ignition Timing Maps:  
 
There are now 34 map pages for complete spark curve modification at any RPM or 
throttle position. The first 32 map pages are called “Timing vs. TPS @ RPM” map 
pages. These pages show the complete spark curves for every 256 RPM, and every 
throttle position.   
In addition to the complete spark curve map pages, two separate map pages have been 
created called “Rear Timing vs. TPS” and “Timing vs. Engine Speed.” The “Rear Timing 
vs. TPS” map page allows you to modify the timing in the rear cylinder only, to combat 
issues of spark knock that occurs only on the rear cylinder. The “Timing vs. Engine 
Speed” map page is a composite timing map page. This table allows you to make quick 
changes to the master spark curve maps at specific RPMs. This map page is very 
effective in dealing with spark knock problems in particular RPMs. See the Ignition 
Timing Maps section, for a complete discussion on how to tune the Ignition Timing 
Maps.  

 
Air/Fuel-TPS @ RPM: (AFR Targets) 
 
With ThunderMax the engines actual Air/ fuel ratio is derived from settings on these 
pages. The settings (targets) are at designated throttle positions and specific RPMs on 
the pages within the software.  
 
When the tuner makes changes to any of the A/F targets the AutoTune system will 
honor the new targets as the engine is operated on a dyno or during actual riding 
conditions. Any ThunderMax equipped motorcycle can be tuned for specific changes of 
desired economy and maximum performance all within one base map.    
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Module Configuration: 
 

1.) Basic Settings – The Basic Settings page is used for editing the Idle Speed, 
RPM limit, Speedometer Calibration, Accel Fuel (accelerator pump simulation), 
Initial fuel pulse,  IAC Home Position and other settings 

2.) Warranty Information – The ThunderMax ECM is constantly data logging while 
you ride and tune the motorcycle. The purpose of this page is to log the time that 
you spend at certain RPM ranges, as well as head temperatures, cycle time per 
riding session, and even how many times the Rev Limiter has been hit. This may 
sound intimidating, but the information is extremely valuable to you. These 
functions will aide any technician in determining why a certain failure occurred. 
The more data that you can provide to Technical Support the easier (and 
quicker!) it will be for them to help you.  

3.) Diagnostic Trouble Codes – The ThunderMax ECM can quickly tell you if any 
of the 38 sensor functions are operating properly or not. If a sensor has failed, or a 
problem with the electrical system exists you will immediately see what the problem 

is on these pages.
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MODULE CONFIGURATION 
BASIC SETTINGS OVERVIEW 

 
As described in the previous section, open the Module Configuration pages in the 
Tuning Maps Tree. Select the “Basic Settings” page under the “Module 
Configuration” heading to open.  The following window will appear.  

 

 
 
Notice that the selections on the right-hand portion of the “Basic Settings” window are 
grey and non-selectable. The features are only available in the Tuner Plus version of 
TMax Tuner. 

 
Read the map from the module before making adjustments to the 
Basic Settings. After making a change to any of the Basic Settings, 
click OK to close that window. The background will remain green and 
show the new value for that field providing that you stay linked. If the 

link is interrupted, the field will be yellow. Re-link and select Write Module 
Settings to complete the change.   
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To change the values of the Basic Settings, simply click on the name of the 
function that needs to be changed. For example, if “Rev Limit” is selected, the 
“Basic Setting Value Entry” box will appear with a slider to adjust the value, as 
shown below.  
 

 
 
 

It is recommended that at this time you make any necessary adjustments to the basic 
settings for the ECM/ motorcycle you are working with. The next section is titled 
“Configuring the Basic Settings.” This section will teach you how to adjust each of the 
functions in the “Basic Settings” window, along with a tutorial on what each of these 
functions performs. Remember, if you do not understand some of the terminology that is 
being presented to you in the manual; refer to the Glossary of Terms at the end of the 
ThunderMax Tuning Manual for assistance.  

 

 



 

 83 

CONFIGURING THE BASIC SETTINGS 

Rev Limit:   
 
At the Rev Limit RPM setting, the system will begin to cut spark to one or both 
cylinders as required to bring engine speed back down below this RPM. 

 
Rev Limit Tip: Know the peak RPM that the engine configuration is 
designed for.  Most V-Twin engines are not designed to run much over 
6,200 RPM.  Use caution with this setting, as a limit that is too high may 
allow mechanical damage to occur to the engine. 

 
Accel Fuel:   
 
This function is similar to an accelerator pump in a carburetor. As the number increases, 
more fuel is delivered to the engine during rapid throttle changes. This setting is pre-set 
to optimum specifications during the creation of the base map; yet differences in injector 
flow rates, changing closed loop targets, or other variables may require some 
adjustment to optimize throttle response. Zipper’s recommends a base setting for Accel 
fuel to be a value of 8 to 14. The Accel Fuel function is meant to be used to optimize the 
off-idle throttle response.  

 
Accel Fuel Tuning Tip - If you experience a pop or misfire in the intake 
tract while blipping the throttle at lower RPMs, lower the Accel fuel value 
until the situation improves.  
 

Speedo Cal:   
 
This setting is a calibration value, which differs in relation to certain years and/or models 
of motorcycles.  Note that an incorrect speedometer calibration can also affect other 
electronic accessory functions. Check the Speedo Cal for your year and model 
motorcycle. If the tire diameter or drive pulley size has changed from stock, contact 
Zipper’s Product Support for information on how to re-calculate the speedometer to a 
new value.  
 

This step must be performed before attempting to ride the motorcycle for the 
first time. Zippers cannot be held responsible for an inaccurate speedometer 
calibration if this step is not followed or neglected. Traffic violations may 
result if your speedometer does not match your local traffic authority’s radar 
gun. The entry can be from 1 to 65,535. At this time, the known base 

numbers are as follows:  
 

2008 42450 
2009 43000 Touring 
2010 44750 
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Idle RPM:   
 
This setting reflects the idle speed at normal operating temperature.  This is used to 
adjust idle speed once the engine reaches full operating temperature. 

TAC Home Position:   
 
The TAC Home Position setting will determine how much air is required to pass by the 
throttle blade for the engine to start without assistance of moving the throttle plate. This 
value indicates the position (in “counts”) of the Idle Air Control (IAC) with the key in 
“RUN”, without the engine running.  This setting affects the amount of air the engine 
receives while cranking.  The TAC Home Position range is from 0 (fully closed) to 255 
(fully open) counts. 
 
Final Drive Ratio:   
 
A setting for “Final Drive Ratio” may only be required if a significant wheel size or 
gearing change is performed and the 6th gear indicator lamp does not illuminate. The 
default value of 87 should work on all vehicles. Please note that this value is merely 
a compensation factor for the calibration needed to activate the light, not the actual 
Final Drive Ratio of the motorcycle. Please disregard this function if you do not have a 
6th gear indicator lamp.  
 
Gear 6 MIN TPS:  
 
This value represents the smallest value of throttle position that will allow the 6th gear 
display to illuminate. This function is only used on motorcycles equipped with OEM 6 
speed transmissions and a 6th gear indicator light on the instrument cluster. If your 
application does not have a 6th gear indicator light, set the value to 0.  
 
The default value for bikes equipped with this feature is 40. For any reason, if your 
6th gear indicator light is inoperable, please confirm that the value in the 6th gear min 
TPS is 40. If not, enter this value and write it to the module. 
 
Initial Fuel Pulse:  
 
This setting will affect the way that the motorcycle starts when the engine is cold. When 
the ignition is turned on, the ThunderMax ECM tells the injector to spray a defined 
amount of fuel to prime the cylinders. The default setting is 199 for most maps. We 
suggest small changes to find the ideal setting for quick starting. Typically when 
properly tuned to the application, the engine will fire “immediately” and eliminate the 
strain on your battery from excessive cranking.  
 
The Initial Fuel Pulse will only pulse the injector once before the engine is started. If you 
lower the setting too much, the function will provide less of an aide in cold starting the 
engine.  
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Cranking Fuel:  
 
This allows you the option to richen or lean the fuel mixture during cranking conditions 
only. The Cranking Fuel option helps the engine start easier by delivering a richer fuel 
mixture to the engine, to promote a quicker initial combustion.    
 
Decel Fuel Cut:  
 
The “Decel Fuel Cut” option is the ON / OFF switch for the Decel Fuel Features. 
 
Using a value of (0) turns the feature off, and a value of (1) turns on this option. For 
example, if your motorcycle does not currently pop on deceleration, it is not 
recommended to activate this feature. If you are experiencing deceleration popping, 
set this value to (1) and proceed forward to setting the Decel Fuel options. 
 
Decel Fuel Cut Rpm Low:  
 
The “Decel Fuel Cut RPM Low” setting should reflect the lowest RPM where the 
deceleration popping is occurring. This feature is set at 2048 RPM by default 
however the setting is adjustable from 1280 to 3040 RPM. Simply take note of the RPM 
where the popping stops and set the “Decel Fuel Cut Rpm Low” value approximately 50 
RPM below this point. This is where the fuel cut process is terminated. Fuel delivery is 
returned to normal below this RPM.  
 
Decel Fuel Cut Rpm High:   
 
The “Decel Fuel Cut RPM High” setting should reflect the highest RPM where the 
deceleration popping occurs. This feature is set at 2400 RPM by default; however the 
High setting is adjustable from 2048 to 4064 RPM. Simply take note of the RPM where 
the popping begins and set the Decel Fuel Cut Rpm High value approximately 50 RPM 
above that RPM. This setting will be the RPM at which the Decel Fuel Cut is triggered 
during acceleration. 
 
The following graph depicts three scenarios to aide in your understanding of the Decel 
Fuel Cut function.  
 

“Action 1” represents a situation where both the Low and High Fuel Cut RPMs 
are achieved; the Decel Fuel Cut is triggered, activated, and deactivated.  

“Action 2” shows a situation where the High RPM was NOT achieved, and the 
Decel Fuel Cut is neither triggered nor activated.  

“Action 3” shows how once the Decel Fuel function is triggered, it will not 
deactivate until after the engine RPM falls below the Decel Fuel Cut Low RPM.  
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Decel Post Fuel Enrichment: 
 
The Decel Post Fuel Enrichment feature is similar to an accelerator pump on a 
carburetor. This enrichment feature smoothes the transition from an OFF to ON 
throttle condition and makes it as seamless as possible. This seamless transition is 
achieved by not allowing the manifold to enter a “dry” condition that can occur on long 
periods of deceleration, which may cause a pause, or a lag, in throttle response once 
the blade is opened. The Decel Post Fuel Enrichment has a range from 0 to 100, with 
the default setting of 16.08.   
 
Engine Temp Alarm Threshold:   
 
An adjustable Engine temperature alarm threshold is a feature that allows you to set the 
cylinder head temperature when the “Check Engine” light turns on, to warn that the 
cylinder head temperature is starting to overheat.  
 
All of the individual models of motorcycles produce different amounts of heat, as well as 
dissipate the heat differently. If you are riding a motorcycle that shrouds the airflow from 
the cylinder heads, the engine will maintain a higher operational temperature over the 
models that do not obstruct the air from the engine. These are air-cooled engines, if the 
air is not flowing past the engine, the engine cannot dissipate the heat.  
 
Now you can select at what temperature you want to be warned, either raising the value 
for motorcycles that are constantly tripping the “Check Engine” light, or lowering the 
value if you want an early warning of a heat build up situation.  
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Auto Tune Low and High Temp Settings: 
  
This setting is non-adjustable, and the value is built into the Base Map. Example: An air 
cooled vs. water cooled engine requires a different temperature threshold for the 
AutoTune to function, the values are set accordingly. 
  
If your application requires a special temperature threshold, please contact product 
support.  
  
Read/Write Module Settings:  
 
The buttons at the bottom of the Module Configuration window allow you to immediately 
save the changes made to the ECM. This is also useful when attempting to read the 
current Module Configuration settings in a module that has already been in operation.  
 
Any changes made when you’re not linked to your ThunderMax ECM will result in a 
value with a yellow background. This simply means that the value is on your computer, 
but not updated to your ECM. In the following example the Decel Fuel Cut option was 
turned on, but not while linked to the ECM.  
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SERVICE DATA 
 
The Service Data window displays the amount of time that you’ve spent at particular 
RPM ranges, as well as the head temperatures that your engine has seen. This is 
extremely useful information when tuning the motorcycle. You will now be able to see 
what RPM ranges are most frequently used by your riding style. This will allow you to 
focus your tuning effort to the most frequently used ranges.  
 
The following window will appear when the “Service Data” option is selected. Select the 
“Read Module” button to update the logged data into the TMax Tuner software. 
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If you are experiencing problems viewing the Warranty Information, please 
verify that the DPI Setting (Dots Per Inch) on your computer is set at 
“Normal Size”, which is 96 DPI. Any value other than 96 DPI may not allow 
this window to open properly. Generally a higher DPI value will eliminate all 

of the buttons found at the bottom of the window. If you don’t see the “Read Module” 
button, double check the DPI setting.  
 
 
The warranty information function is viewed as three separate logs, one based on 
General Log Data, one on RPM and one based on Head Temperature. To toggle 
between the logs, simply select which log you wish to view from the separate tabs at the 
top of the window. 
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If the “Head Temp Log” tab is selected, the following window will appear.  
 

 
 

Saving the Warranty Information Data: 
 
To save the Warranty Information data that is stored in the ThunderMax ECM, first 
select the “Save to File” button at the bottom of the “Service Data” window, as shown 
above. 
 
Once the “Save to File” button is selected, a window will appear titled “Save As.” 
 

 
 
Select “Save” and an Excel spreadsheet will be created in the directory “C:\Documents 
and Settings\All Users\Documents\Thunder Heart\TMaxI_Tuner\Warranty Data.”  
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 Two files will be created when a Warranty Data Log is saved. The first file is an Excel 
Spreadsheet that contains ALL of the data displayed on the “Service Data” windows, 
including both Head Temperature and RPM logs. This Excel spreadsheet can be printed 
out for your reference.  
 
The second file that is created is an .SSD file which can be opened through TMax 
Tuner. If you select the “Load from File” button, as shown below, TMax Tuner will open 
the Warranty Data folder for you to choose a saved warranty log for viewing.  

 

 
 
 

Select a Warranty Data 
Log file and click 
“Open” to view. These 
files are listed by date 
and time, down to the 
second. 
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DIAGNOSTIC TROUBLE CODES 
 
When the Diagnostic Codes option is selected from the Tuning Maps Tree (Subcategory 
of Module Configuration), the following window will appear: 
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Open the Diagnostic Trouble Codes window when linked to your ThunderMax 
ECM to view the Diagnostic Trouble Codes status.  
 
The Diagnostic Trouble Codes window displays counts, current and historical errors 
for all of the sensors and devices that are necessary for the proper operation of your 
motorcycle. These windows eliminate the need for the factory scan tool for reading 
trouble codes. Instead of outputting a trouble code, this window will display the status of 
the electronic system.  
 
 
Three types of messages are given in the DTC window, (1) Counts which are not DTC, 
(2) Current errors, (3) Historic Errors  
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Low battery voltage will result in a Fault Code as well due to low return voltage from the 
sensors.  With an extended session of linking without the engine running, a charger may 
be properly connected to the battery before prolonged link sessions, but only with the 
engine off. Otherwise you may have a weak battery when you try to crank the engine 
over. Removal of the headlight fuse will greatly reduce battery drain while linked. 
 
The Diagnostic Trouble Codes are useful when troubleshooting electrical issues with 
your motorcycle. Most all problems we have encountered thru development are related 
to ECM connector problems, faulty wiring, adding incompatible electrical accessories, 
faulty TSSM. If an error is occurring with a sensor, but you only see a Historic Code, 
use the “Clear Diagnostic Codes” button to clear the historic codes. If the code is 
current and it re-appears after you clear it, start your inspection of new devises added to 
the cycle or work thru the factory manual to locate the problem in the system. 
 

Current Fault 
– A fault is 
occurring with 
the sensor in 
question. A 
TPS Low 
“Current Fault” 
simply means 
that the sensor 
voltage is 
currently too 
low to operate 
correctly.  

Historic Fault – A 
fault has previously 
occurred in the past, 
or is a present 
problem if “Current 
Fault” is displayed. 
If only the Historic 
Fault is shown, and 
no issues are found 
with the motorcycle, 
the fault will 
eventually clear 
itself. 

Counts – This is the 
test mode counting - 
scanning system 
integrity.  
 
A numeric value 
listed within the left 
column (counts) is 
not a DTC fault 
code. 
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The DTC uses abbreviations for the sensor names, and it will show if the sensor voltage 
is too high, or too low for the normal operating range. 
 
TPS Low / High = Throttle Position Sensor 
MAT Low / High = Manifold Air Temperature 
Head Temp Low / High = Cylinder Head Temperature 
Barometer Low / High = Barometric Pressure Sensor in the ECM 
EGO Front / Rear = Oxygen Sensor Front / Rear Status – The engine must be 
operating for this function to correctly diagnose the oxygen sensors.  
Battery Low / High = Main 12v Battery Voltage 
Sensor Power Low / High = Voltage across the low power sensor circuit (Factory 
equipped 5 volt sensor circuitry) 
Crank Sensor = Crank Position Sensor (CPS) 
Vehicle Speed = Vehicle Speed Sensor (VSS) 
Calibration Integrity = Reserved for future upgrades, currently non-functional 
Firmware Integrity = Reserved for future upgrades, currently non-functional 
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 CLOSED LOOP MODULE SETTINGS 
 

The Closed Loop Module Settings are used in conjunction with the ThunderMax ECM.  
 
The ThunderMax ECM processes feedback from the wideband oxygen sensors to 
adjust the fuel volume at all points, by creating learned “Offset” points from the installed 
‘Base Map’ fuel points. These ‘learned offset points’ are stored within the ThunderMax 
ECM and are used in conjunction with the base map. The base map is dynamically 
used by the ThunderMax ECM Auto-Tune’s active (closed loop) feedback system. The 
‘base map’ fuel points are not being adjusted by the ThunderMax AutoTune system.   
 
To view the Closed Loop MODULE Settings window, select Configure > Closed Loop 
MODULE Settings… as shown below.  
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Closed Loop Configuration Layout: 
 
The Closed Loop Configuration window is broken into two distinct columns, one for the 
Module settings, and one for the Map settings.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Left Side 
(Module Side) 

 
Closed Loop 

Settings saved  
in your 

ThunderMax 
ECM. 

 
 Changes made to 
the Module side 
are only saved if 

Linked to an 
ECM.   

Right Side 
(Map Side) 

 
Closed Loop 

Settings saved 
to the Map file 

on your 
computer. 

 
Any changes 
made to the 

Map side must 
be written to the 
ECM before the 

changes are 
implemented by 

the 
ThunderMax 

ECM. 
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Enabling Closed Loop Operation:  
 

1.) Establish a communications Link to the ThunderMax ECM.  
2.) Select Configure > Closed Loop Module Settings… 
3.) Check the “Auto Tune (Module)” and “Auto Tune (Map)” options as 

shown below, if not already checked. 
 

 
 

4.) Select the “Write (Map) Settings to (Module)” button at the bottom of the 
Closed Loop Configuration window. 
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Air Fuel Ratio Override: Race Mode 
 
The Air Fuel Ratio Override function overrides ALL ‘Air/Fuel Ratio vs. TPS’ pages at 
ALL RPMs when you check the AFR Override Enabled box.  

 

 
 
 
The following box will appear to allow you to change your Target AFR. Once adjusted, 
select OK and “Write (Map) Settings To (Module)” to update the ThunderMax ECM.  
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To target specific Air/Fuel Ratio RPM ranges and throttle positions, leave this box 
unchecked and edit the individual ‘Air/Fuel-TPS @ rpm’ map pages located under the 
‘Tuning Maps’ tree.   
 
  
Max Session CLP Offsets: 
 
The Maximum CLP Offsets section allows you to adjust the amount of Closed Loop 
learning corrections. This simply means that you can alter the range that the Auto-Tune 
unit can tune away from the Base Map file, with a limit on allowed tuning per session, as 
well as an overall limit regardless of time.  
 
 

 
 

 
The “Session (Map)” button sets the AFR maximum learning correction from the Base 
Map’s fuel setting, per session; by percentage (range is 1-10%).  A ‘session’ is defined 
as the period of time from engine on to engine off (per cycle). The “Use Max Session 
Default” option sets the session learning to the maximum percentage of 10%. This 
option must be written to the module, if selected, using the “Write (Map) Settings To 
(Module)” button.  
   
 
The “Maximum (Map)” button sets the total AFR maximum learning correction from the 
base map’s fuel setting by percentage (regardless of number of sessions; range is 0-
10%).  
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TMAX TUNER HOT KEY COMBINATIONS 
 

At any point when TMax Tuner is open, if you select the “F2” button, the following 
display will appear, titled “Hot Key Combinations”. Draw focus to (left click inside) any 
tuning map graph and select F2 to open the hot keys window.  
 

 
 

The TMax Tuner Hot Keys are meant for users who are comfortable with the layout and 
features of the software, but are looking for a quicker means of navigating the software.  
 
Essential TMax Tuner Hot Keys: 
 
[Home] – The Home key will select the FIRST tuning block map point on the displayed 
map file page. (Leftmost map point) 
[End] – The End key will select the LAST tuning block map point on the displayed map 
file page. (Rightmost map point) 
[Spacebar] – The spacebar will toggle the “Tuning Block Details” box, which displays 
the live data associated with each tuning block.  
[◄►] – The left and right arrow keys, ◄►, allow you to move between 
highlighted, or active, tuning blocks.  
 
 
[▲▼] – The up and down arrow keys, ▲▼, allow you to move a highlighted 
tuning block either up or down. Quite simply it’s the arrow keys that allow you to 
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navigate through the Base Map File map pages and make adjustments to the 
tuning blocks.    
 
Tuning Related TMax Tuner Hot Keys: 
 
[L]  - To create a linear line between two points, tap the L key on the first point, then 
move to the second point and tap the L key.  
 
[L][L] – To create a horizontal line from a selected tuning block to the end of the map 
page (right-hand side), tap the L key twice in a row.  
 
[CTRL] [L] – If you decide to undo an [L][L] command, holding down the Control [CTRL] 
key and selecting the L key again will undo the last linear line command.  
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TMAX TUNER HELP SECTION 
 

 
 
TMax Tuner Help Menu Breakdown:   
 

1.) ThunderMax Tuning Manual – A complete Reference Guide to installing the 
ThunderMax TBW ECM, navigating through the TMax Tuner Software, and 
Tuning / Troubleshooting a ThunderMax ECM. 
 

2.) USBSER Driver installation guide- A complete Reference Guide to 
installing the driver for USB interface between the ECM and your PC. 

 
3.) Online Help Documents – External Link for Online documentation / 

software– www.Thunder-Max.com 
 

4.) ThunderMax Website - External Link for the ThunderMax website 
www.Thunder-Max.com 

 
5.) Prepare and Send, Module Data Email – This function will download the 

Base Map and all offsets from your ThunderMax ECM, package the contents 
into an email, and send it to the ThunderMax Product Support Team for 
review.   

 
6.) Create and Send, Monitor Log Email – This feature works in conjunction 

with the Monitor Logging process. When selected, this feature will start a 
Monitor Logging session, and email it to the ThunderMax Product Support 
Team upon completion of the session.  

 
 
7.) About TMax Tuner … - As mentioned before, this window displays the 

current version of TMax Tuner software, as well as the firmware version and 
date, if linked to a ThunderMax ECM.  
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PREPARE AND SEND MODULE DATA EMAIL 
 
In an effort to greatly reduce the time from problem identification to solution, a very 
powerful tool has been added to TMax Tuner. The “Prepare and Send, Module Data 
Email” function was developed to maximize the data from the End User to the Product 
Support team upfront. With the proper data known in advance, most problems or issues 
can be resolved in a minimal amount of down time to the user.  
 
An email client must be installed on your computer for this function to work, i.e. 
Microsoft Outlook, or Outlook Express. If you only have a web-based email address, 
you can still send your map to Product Support; however it will take a few additional 
steps. Complete step by step instructions are available at the end of this section.  
 
To send your Base Map to the Product Support team, you must be linked to your 
ThunderMax ECM through TMax Tuner. Select Help > Prepare and Send, Module 
Data Email, as shown below.  

 

 
 
The following prompt will appear; simply select YES to continue:  
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The process will begin automatically. First the following box will appear and the Module 
Maps and settings will be read from the ThunderMax ECM.  
 

 
 

Next, the following window will appear as the Learned Fuel Offsets saved in your ECM 
are downloaded and recorded.  
 

 
 

While reading the Learned Fuel Offsets, the software will begin displaying the Front 
Cylinder Fuel Flow map pages, one by one as the offsets are downloaded and 
displayed. Once a particular RPM map has downloaded and the Learned Fuel Offsets 
appear, TMax Tuner will immediately move on to the next RPM page.  
 
ALL of these Learned Fuel Offsets can be read individually through the software after 
this is complete; this is not the only chance that you’ll get to be able to view the offsets. 
A typical screenshot of what appears on your screen while downloading the Learned 
Fuel Offsets is shown below:  
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Once the Base Map, Module Settings, and Learned Fuel Offsets are downloaded from 
your ECM, the following window will appear, titled “Support Email Creation.” 
 

 
 
At a minimum, fill in your name, phone number, and the basic information on your 
motorcycle, and issue, in the box on this window. The more information that’s given 
upfront, the faster the Product Support Team can fulfill your request for help. Help 
us help you!  
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Once you’ve filled in as much information as possible, select the “OK” button on the 
“Support Email Creation” window. The following box may appear: 
 

 
 
This is a warning that was generated by Microsoft Outlook, due to TMax Tuner creating 
and attempting to send an email on its own. If you choose “No”, a box will appear that 
simply says “Failed.” If you choose “yes” and allow TMax Tuner to send an email for 
you, the following will appear if successfully sent. To ensure that the email was 
successfully sent, double check the contents of your “Sent Items” folder in Outlook.  
 

 
 
If you do not have an email client loaded on your computer, this function cannot send 
any emails. The following error will appear if a supported email client is not found;  
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If you do not have an email client loaded onto your computer, you can 100% replicate 
this function by yourself with a few additional steps. The “Prepare and Send Module 
Data” function simply does steps 2-5 for you.  
 
 Web-Based Email: (G-mail®, Yahoo®, etc.): 
 
  1.) Link to the ThunderMax ECM  
 

2.) Read Module Maps and Settings from the File menu 
 
3.) Read Learned Fuel Adjustments from the Map Editing menu (if not 
automatically read). 
 
4.) Using the “Save As” menu option, save the file onto your desktop, 

altering the last 6 digits of the Base Map name to the date that you’re sending the 
email, (MM, DD, YY). For example, if you’re using Base Map 
HBSSBBSAAN011110.slk, simply change the 011110 to HBUSSXSGUG012710, 
for Jan. 27th, 2010.  

 
5.) Attach this saved map file to an email in your web-based email 

client, and send to ProductSupport@ZippersPerformance.com. Please put the 
following in the e-mail’s subject line “TMax Tuner Support Request.”  

 
In the body of the email, please list the following information: 
 

a.) Year and model motorcycle 
b.) Engine Displacement (Bore and Stroke, if known) 
c.) Exhaust System Style / Brand (True Duals, Factory head pipes 

with slip-ons, 2 into 1, etc.) 
d.) Issue, problem, question, etc. The more information you can 

relay to the Product Support team, the better chance we have of 
solving your problems in a timely manner.  
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CREATE AND SEND MONITOR LOG EMAIL 
 

The second major support tool that has been added to TMax Tuner is similar in 
operation to the “Prepare and Send Module Data Email” feature. This function will allow 
you to create and save a monitor log session and TMax Tuner will email the data to 
Product Support for you.  
 
This function will only work if an email client is loaded onto your computer. Web- based 
email users can duplicate this entire process and submit monitor logs for review, 
however additional steps are required. Please see instructions on how to manually 
email a monitor log to the Product Support team.   
 
To access the function, select Help > Create and Send, Monitor Log Email.   
 

 
 

The following box will appear: 
 

 
 
Select “Yes” to continue in creating a Monitor Log, and emailing it to Product Support. If 
“Yes” is selected, the following box will appear: 
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Once activated, the monitor logging session begins. Use monitor logging to record 
oddities in operation of the ThunderMax ECM.  Allow monitor logging to continue long 
enough to capture any unusual events (or from cold start to operating temp. 275°). To 
end the log session, select “Stop monitor Logging”. The combination of a monitor log 
and a saved Base Map file with Learned Fuel Offsets is almost as good as having a 
ThunderMax technician evaluate the operation of your motorcycle first hand.  
 
Once the logging session is complete, the following window will appear:  
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At a minimum, fill in your name, phone number, and the basic information on your 
motorcycle, and issue, in the box on this window. The more information that’s given 
upfront, the faster the Product Support Team can fulfill your request for help. Help 
us help you!  
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Once you’ve filled in as much information as possible, select the “OK” button on the 
“Support Email Message” window. The following box may appear: 
 

 
 
This is a warning that was generated by Microsoft Outlook, due to TMax Tuner creating 
and attempting to send an email on its own. If you choose “No”, a box will appear that 
simply says “Failed.” If you choose “yes” and allow TMax Tuner to send an email for 
you, the following will appear if successfully sent. To ensure that the email was 
successfully sent, double check the contents of your “Sent Items” folder in Outlook.  
 

 
 
If you do not have an email client loaded on your computer, this function cannot send 
any emails. The following error will appear if a supported email client is not found. 
 

 
 
If you use a web-based email, see instructions on how to manually send a monitor log 
to the Product Support Team.  
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This window appears if no link is found to the module. 

Follow the steps listed in this window to establish a link to the module. 
 

 
 
 

This window quickly follows. 
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TUNING OVERVIEW 
 

ThunderMax TBW system is the most advanced tuning system available. This package 
will save you or your tuner significant time and money in properly tuning your engine, 
and maintain the proper tune regardless of changes in ambient conditions you operate 
your engine under.  
 

IMPORTANT NOTE 
 

If you desire to change the A/F at specific RPMs or throttle positions you must 
alter the corresponding A/F target, example page is listed below.  These targets 
are the commands which the ThunderMax system will honor during engine 
operation even as ambient conditions change.  Learned fuel offsets created by 
ThunderMax system are applied between 200-280 degrees engine temperature.  , 
Dyno tuning, power sampling or driving the engine under normal riding 
conditions, must be performed at the above engine temperature to record the fuel 
adjustments.  

  

 
 
 
 
 
 
 
 
 
 

The “Tuning 
Blocks” can 
be moved 

either up, or 
down by using 

the Arrow 
Keys (▲▼) on 

your 
keyboard. 

 
The left or 

right Arrow 
Keys (◄►) 
change the 

selected 
Tuning Block. 

Select the Map 
page with your 
mouse to Draw 

Focus to the 
window. 

 
Tap the 

SPACEBAR on 
your keyboard 

to enable / 
disable the 

“Tuning Block 
Details” 
window. 

Active 
Monitor 
Gauge 
Display 
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TMAX CLOSED LOOP AUTOTUNE 
 

The ThunderMax TBW with AutoTune uses rapid feedback from wideband oxygen 
sensors to achieve given AFRs as requested in the base map. The fuel added, or 
removed, from the Base Map is commonly referred to as “fuel offsets.” These fuel 
offsets are constantly being created and adjusted by the TMax AutoTune system.  
 
Even without a dynamometer, it is possible to tune almost any engine combination with 
ThunderMax simply by allowing the AutoTune system to create fuel offsets from a 
chosen Base Map. To accelerate the efficiency and speed the learning of the AutoTune 
system, it is highly recommended that you link to your ECM, and perform an “AutoMap” 
process to the Base Map.. This simply means that you run the motorcycle with the 
closest Base Map then use the “AutoMap” process to write these learned offsets as 
your new Base Map. Now the AutoTune system is adjusting around the new Base Map 
points. If your engine combination is significantly different than the Base Map, it may 
take 2-3 “AutoMap” sessions to fully generate a custom Base Map. 
 
Accelerated Auto Map Procedure:  
 

 
1.) Select TMax Control Center and observe the information given in the Auto 

Tune Checkup window for advice on the maps status. 
 

2.) Select Run AutoMap to initiate the process and follow the prompts to complete 
AutoMap.  

 
 

3.) Do not disturb this process! TMaxI is converting the Learned Fuel Offsets 
into Base Map Fuel Points. 

 
 

4.) The base map has been successfully revised and smoothed, now simply test 
the results.  

 
 

If an improvement was made, but the tuning is not complete, ride the motorcycle to 
generate additional fuel offsets, and repeat this process. It may take a few cycles of this 

Accelerated Auto Map Procedure to fully create a custom Base Map for your 
application. At least 2 cycles of riding and writing the offsets is recommended for any 

application.
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FRONT CYLINDER FUEL 
(Front Fuel Flow vs. TPS) 

 

 
 
The Front and Rear cylinder Fuel Flow tables are visible in TMaxI. These are the map 
pages that define how much fuel is required to maintain the Target AFR for the base 
map. All of these curves were generated on a load-cell dynamometer for a specific base 
map.  
 
Shown above is a 2816 RPM map page with a typical fuel curve. The red blocks are the 
Base Map fuel points, and the green boxes represent a Learned Fuel Offset. The 
AutoTune system creates, and constantly adjusts the green Learned Fuel offsets to 
maintain the Target AFR. On the 2816 example shown above, the Base Map is a close 
match to the engine combination chosen, which can be seen by the tightly held offsets 
to the Base Map points. An alteration in the AFR vs. TPS map pages will result in 
additional movement of the green Learned Fuel Offsets. Don’t be alarmed if your offset 
points are farther away from the Base Map than the example shown. This is simply the 
AutoTune working to customize your map to your motorcycle. 
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REAR CYLINDER FUEL 
(Rear Cylinder Trim vs. TPS) 

 

 
 
The rear cylinder fuel flow is seen as a “trim” to the front cylinder fuel flow. The front and 
rear cylinders are adjusted individually to maintain the proper AFR Target in each 
individual cylinder. The theory behind this operation is very simple, the front and rear 
cylinders always require a different amount of fuel flow to maintain the same Target 
AFR. Many of our competitors do not understand this, or they simply chose to ignore it. 
Tuning both cylinders individually is the only way to properly tune a V-Twin 
engine. The AutoTune / ThunderMax system not only understands this, it does all of the 
hard work for you! 
 
With a shared manifold that’s optimized for space instead of individual cylinder fill 
requirements, the cross talk in the intake tract, coupled with particular exhaust pipe 
designs, on an HD engine, creates a large difference in fuel flow requirements at 
specific throttle positions and RPM. The rear cylinder trim system, coupled with the 
AutoTune system, stabilizes each cylinder under any conditions.  
 
Warning: The trim curves for rear cylinders may look quite unusual in comparison to the 
front cylinder’s fuel curves. Expect offsets on the rear cylinder at much greater 
amplitudes than the Learned Fuel Offsets from the front cylinder. This is typical! If you 
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are concerned with the results that you’re seeing, please go to the correct manual 
section and read about the “Prepare and Send Module Data” function. A trained Product 
Support technician will be able to assist you in evaluating your Learned Fuel offsets.  
 
You may also proceed to the “TMax Control Center > Details” button for an immediate 
summary (Fuel Adjustment “Offset” Summary) of exactly how many offsets have been 
created and how far they’ve moved. This information may also be accessed from the 
“Tools” menu, under the “Auto Tuned Points Analyzer” selection.  

 
 
 
 



 

 121 

IDLE SPEED RPM (OFFSET) VS ENGINE TEMP 
 

 
 
The Idle Speed vs. Engine Temperature map page is a graph comparing the engine 
temperature to a designated RPM. Generally speaking as the engine temperature rises, 
the idle RPM will decrease.   
 
The ThunderMax ECM uses this page to dictate the idle RPM of your engine. The Idle 
Speed vs. Engine Temperature map page is changed by the Idle RPM value in the 
Basic Settings window. Changes to the “Basic Settings” Idle Rpm will change this Idle 
Speed vs. Engine Temperature map page for you in the normal operating temperature 
range.  
 
Idle Speed adjustment- Most of the base maps in the ThunderMax data base are 
calibrated to idle between 900-950 RPM. To reduce the idle speed, the low speed map 
pages must be recalibrated. This is done by lowering the idle speed in increments of no 
more than 100 RPMs and running the engine to allow learning of the map pages. Once 
the AFR becomes stable, you can further lower the idle speed until the desired RPM is 
reached.  
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If you decide to change the Idle RPM of your engine, please note that changes are 
automatically made to the “Idle Speed vs. Engine Temperature” map page. Changing 
the Idle RPM in the “Basic Settings” Window only changes the Idle Speed vs. Engine 
Temperature map page in normal operating conditions. Make any further adjustments 
manually, if necessary, after you have reached your desired Idle RPM. Please examine 
the following map page shown; this is an example of what happens when you alter the 
Idle RPM from 928 to 864.  

 

 
 
 
 
 
 
The Idle Speed vs. Engine Temperature map page now shows the current and previous 
positions of the tuning blocks. At 303 degrees, the map begins to climb back up to the 
default Idle RPM. It is recommended to blend the end of the curve to match the normal 
operating temperature Idle RPM. Select the 303 degree map point, then select the “L” 
button twice to activate the TMaxI Hot Key [L][L] Straight Line fit function. The curve 
should now follow the normal operating temperature Idle to the right side of the  
map page, as shown below. Manually moving the blocks into a straight line will achieve 
the same results.  
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The reason for reducing the Idle RPM in a high heat situation is quite simple. A lower 
Idle RPM produces less heat. This will slow down the build up of heat, which reduces 
engine power, prematurely wears key engine parts, and ultimately can cause a 
catastrophic failure. 
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AFR CORRECTION VS ENGINE TEMPERATURE 
 

+  
 
The AFR Correction vs. Engine Temperature map page should not be used as a “tuning 
map” page; rather it should be used as a tool to remedy problems relating to AFR 
stability at specific warm up head temperatures. If the engine is acting erratically at 
certain temperatures during warm up, usually in cold weather, but it returns to normal 
operation by the end of the warm up period, you may need to alter the AFR Correction 
value at those specific temperatures to remedy the A/F problem.  
 
The AFR Correction vs. Engine Temperature page allows you to make changes at 
specific temperatures where the problem may exist, without changing the AFR at 
normal operating temperature.  
 
Never adjust the entire map structure at all temperatures, doing so will affect all 
engine operating temperatures, which will alter the AFR during normal operating 
conditions. Before adjusting this page, make sure that you have a stable and equal AFR 
at idle, while at normal operating temperature.  
 
If the idle is not stable when fully warmed up or at all temperatures adjust the fuel points 
on the front cylinder fuel page, keep adjusting the points until you can make the A/F 
stabile then with the motorcycle in neutral and on the kickstand. Turn the throttle until 
the engine RPM is approximately 1280 and observe the AFR, then repeat at 
approximately 1536 RPM. If the engine is erratic at idle, but stable at the two higher 
RPM points, then the AFR Correction is not the culprit of the instability. Modify the Front 
Fuelflow vs. TPS page at the idle RPM to correct this issue. If the same instability is 

Select the 
Map page 
with your 
mouse to 

Draw 
Focus to 
the graph 

before 
making 

changes. 
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present at the 1280 and 1536 RPM pages, then the issue can be solved by the AFR 
Correction value.   
 
Let the engine cool down, use a fan to speed up the process, if the vehicle can be 
checked again by allowing it to sit overnight, while linked to the motorcycle, start the 
engine and carefully observe the AFR on both cylinders. The engine should be 
operating within the A/F target, approx. 12:1 to 12.5:1 range during warm up, from the 
coldest point to 160 degrees F. Somewhere between 160 and 180 degrees cylinder 
head temperature, the AFR should achieve the Target AFR as set on the AFR vs. TPS 
pages.  
 
During the warm up period, from cold start to 160 degrees, if you observe the AFR 
move outside of this 12:1 to 12.5:1 range, record the temperature range that this occurs 
in, as well as the AFR value that it shifts to. Minor variations are acceptable, just monitor 
the idle stability and focus on the problematic region. With this data, you can now 
modify the AFR Correction vs. Engine Temperature map page.  
 
Let the engine cool down again, and bring it back up to the problematic temperature 
range. As the engine is warming up and the AFR is outside of the 12:1 to 12.5:1 range, 
move the AFR Correction blocks up or down to correct the AFR in real time. By knowing 
in advance the problematic temperature range, you’ll have a much better chance of 
correcting it the first time. The motorcycle warms up pretty quickly, so the timeframe to 
make these adjustments is relatively small. If you pass the problematic spot without fully 
correcting the AFR, you will need to cool the engine back down below that region, and 
start over.  
 
With the Closed Loop AutoTune system, it is unlikely that this page will ever need to be 
adjusted. The AutoTune system has enough adjustment to correct any potential Idle 
Speed issues. If you are experiencing an unstable Idle, please double check that you’ve 
loaded the closest Base Map to your application, and that your module has been 
properly initialized.  
 
In a Closed Loop AutoTune application, it is recommended that you increase the closed 
loop session limit to 10% prior to attempting to modify the AFR Correction vs. Engine 
Temperature map page. This will expand the allowable AutoTune range, which should 
correct any warm up issues. However, if you do need to modify the AFR Correction vs. 
Engine Temperature map page, always monitor the front & rear cylinder AFR’s in the 
TMaxI software to observe what AFR changes need to be made, and then to measure 
the results of your changes.  
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AFR VS ENGINE TEMPERATURE 
 

 
 
The AFR vs. Engine Temperature Map Page works in conjunction with the AFR Target 
pages, adding correction to the AFRs at specific engine temperatures. 
 
For example, if you observe the AFR in both cylinders, in conjunction with the AFR 
target window on the monitor page, you will notice the target AFR leans out as the 
engine approaches normal operating temperature. This phenomenon is the AFR vs. 
Engine Temperature at work.  
 
To observe the correction applied at a particular engine temperature, select the 
appropriate tuning block and press the space bar to read values. Lowering the blocks 
richens the measured AFR, and raising the blocks leans the AFR. If the measured AFR 
is too rich or too lean during lower temperature operation, adjust the blocks accordingly 
on this page to achieve the AFR correction to the AFR Target page.  
 
It is not recommend that changes be made to this map page unless instructed by 
Zipper’s Technical Support.  
 

LEANER 
 
RICHER 

“0%” AFR 
Adjustment = 
Base Map 
Setting 
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IGNITION TIMING MAPS 
 

There are many variables associated with proper ignition timing; for this reason, it is 
impossible for the ThunderMax Base Maps to be a perfect match for every situation. 
The good thing is that the adjustability of the ThunderMax ECM allows the user or tuner 
to set the ignition timing for his / her individual motorcycle. The key to correcting a 
pinging issue is to identify the severity of the problem. Would you consider the pinging 
issue to be light to moderate, with an occasional occurrence, or do you have a severe 
pinging problem? Do you know at what RPM the pinging is occurring? 
 
Severe Pinging: 
 
If you have a severe pinging problem, a change needs to be made immediately to your 
ThunderMax ECM. It is not recommended to continue operating the motorcycle if the 
pinging problem is severe, damage to the engine can occur if the issue is left 
unattended.  
 

1.) The first thing to do with a severe pinging problem is to double check that the 
Base Map you’re using is close enough for your application. Use the instructions for 
choosing a map to determine if you have the closest Base Map for your application 
following the “Key Elements” listed. If you find a closer Base Map, try using it before 
modifying anything.  
 

2.) If you already have the closest Base Map for your engine combination, you 
should immediately begin retarding the timing on the “Timing vs. Engine Speed” map 
page. Knowing an approximate RPM range of the pinging will help you correct the 
problem quickly. If you do know the RPM range of the problem, simply remove several 
degrees of timing in the area of the pinging in an attempt to minimize it. Repeat until the 
majority of the pinging has been eliminated from normal use. If you do not know an 
RPM range, start removing 1-2 degrees of spark timing across the operating range of 
the engine. Repeat until the pinging has been greatly reduced.  

 
3.) Once you’ve removed enough timing to control most of the pinging, move to 

the next section titled “Light or Occasional Pinging.” Now that you’ve gotten the ignition 
timing much closer and removed most of the pinging, the following section will help you 
determine what is causing the issue, and how to address it.  
 
Light or Occasional Pinging: 
 
A light or occasional pinging problem can be caused by many variables, from the 
components used in the engine (cams, compression, exhaust system) to the overall 
motorcycle setup (passengers, trailers, cargo / gear, trike conversion kits). In addition to 
the motorcycle setup, the terrain you’re traveling on greatly effects the loading of the 
engine, which is a variable in ignition timing and spark knock control. The ThunderMax 
ECM, unlike most of its competitors, gives the user complete control of the ignition 
timing for your engine. The key to solving spark knock is in identifying the RPM that the 
pinging occurs and the AFR that the engine is achieving at that point. To aide in solving 
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a light to moderate pinging problem, read the following 2 scenarios, and follow the 
instructions of the scenario that best describes your issue. The first scenario is a new 
ThunderMax installation with little to no ride time, or a change has been made to the 
engine or motorcycle (weight) on a good running ThunderMax installation. The second 
scenario is when pinging is only experienced while riding long distances, or on high 
mileage out of town trips.  

 
1.) A new ThunderMax installation with little to no ride time or a change has 

been made to the engine or motorcycle (weight). 
 
If you’ve just installed the ThunderMax ECM, or have only ridden the motorcycle 

a few times prior to installing, the AutoTune system is still working on achieving the set 
AFR Targets. Continue riding the motorcycle to see if the situation improves. Several 
riding sessions, and a few hundred miles should be ridden before any major changes 
are made. Use the “Accelerated AutoMap Procedure” section for instructions on how to 
Read & Write your fuel offsets as the Base Map. The AutoTune system may solve the 
occasional pinging issue simply by achieving the proper AFR Target.  

 
If an engine modification has been made to a known good running motorcycle, 

and pinging is a result, you may need to load a new Base Map, or modify the “Timing 
vs. Engine Speed” page. Camshafts, big bore kits, and compression changes can have 
a large effect on required ignition timing. If weight is added to the motorcycle, the 
loading of the engine changes dramatically. Trailers, passengers, heavy cargo, and trike 
conversion kits all change the overall vehicular weight, and will force you into different 
throttle positions for the same speed range.  

 
View the TMax Control Center or the AutoTune Points Analyzer for clues to the 

amount of offsets generated by the AutoTune system. If the information there is telling 
you to choose a new Base Map, see the instructions on Base Map Selection. 
Otherwise, proceed to the Ignition Timing Maps section for an explanation on how to 
modify the “Timing vs. Engine Speed” map page.  

 
If the AutoTune Points Analyzer (TMax Module Control Center) only leaves you 

with more questions, see the instructions on how to use the “Prepare and Send Module 
Data Email” function. This will send your map and offsets to the Product Support Team 
for review. In this situation, a new Base Map may be suggested, or a modified version of 
your current Base Map may be returned to you. 

 
If you believe that you have the proper Base Map, you may begin modifying the 

“Timing vs. Engine Speed” map page, as described in the Ignition Timing Maps section. 
If you know the RPM range of the pinging issue, start by removing several degrees of 
ignition timing from this area. If this does not fully remove the pinging, you may need to 
modify the AFR Targets in this same RPM range to fully remove the pinging.  

 
To modify the AFR Targets at the RPM of the pinging, use the “AFR vs. TPS” 

pages, as described in the AIR FUEL RATIO VS TPS @ RPM PAGES section of this 
manual. Adding fuel to the areas of spark knock will help cool the combustion chamber, 
which will reduce the pinging. Adding fuel by itself is a help yet rarely the solution, but a 
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combination of increased fuel and decreased ignition timing will yield the best results. 
Try setting the AFR Override at 12:1 to see if the problem goes away. If it does, turn off 
the AFR Override and begin modifying the AFR vs. TPS Target Pages to 12:1 in the 
RPM range, and throttle position, of the pinging. Knowing where the pinging is occurring 
is always the key to eliminating it 

 
2.) Pinging is only experienced while riding long distances, or on high 

mileage out of town trips. 
 
Due to the regional differences in fuel blending, you may only be experiencing a 

spark knock situation due to a poorer quality of fuel than you’re normally used to. In 
addition, if you’re traveling with a passenger and / or gear, you have changed the weight 
of the vehicle enough to alter the loading of the engine. Terrain changes may amplify 
the problem if you’re heavily loaded with gear, and now you’re going uphill, which adds 
even more load on the engine. If you’re on the road and have no way of linking to the 
ECM, when possible reduce the load to the engine and try a higher quality gasoline and 
/ or a bottle of octane booster. This may help reduce the pinging. 

  
TMaxI Timing Control Features: 
 

1.) Full “Timing Curve” Map Pages - A map page is available for every 256 
RPM, showing the full ignition curve for each RPM, 32 pages total. These shapes were 
created on a load-cell dynamometer with the specific parts listed in the Base Map 
definitions. It is best that changes made to these pages are attempted last, after 
modifying the “Timing vs. Engine Speed” page, and only with the knowledge of the live 
AFRs. Significant alteration of these pages should be performed on a load-cell dyno by 
a trained technician.  

 
2.) Rear Cylinder Adjustment – A page titled “Rear Timing vs. TPS” is now 

available, this page allows you to make fine adjustments on the Rear cylinder only to 
offset any situations where the rear cylinder requires a different timing. Most cases will 
not require Rear cylinder adjustment, only make changes to this page if you’ve 
validated that your rear cylinder requires a timing adjustment on a dynamometer. No 
data = no adjustment.  

 
3.) Timing vs. Engine Speed – This composite timing map allows for a quick 

view of the overall timing scheme, and eases adjustment with an easier to understand 
map page. This page shows the wide open throttle curve; adjustments to this page 
move all 64 points on each particular RPM curve map page.  
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Timing vs. TPS @ RPM; Full Timing Curve Map Pages: 
 

 
 

The 32 Map pages that display the Timing vs. TPS @ RPM are now available to all 
users of TMaxI. These pages contain the complete timing curves used by the 
ThunderMax ECM. Remember that each page is a static RPM page, relating the Timing 
in degrees to the Throttle Position.  

 
You can cause serious engine damage if the timing is set too aggressively. 
If timing changes are being tested on a road environment, great care must 
be taken in watching your surroundings and staying safe.  
 

Since the Timing vs. TPS @ RPM map pages were developed at Zipper’s on 
dynamometers using sophisticated equipment, it is impossible for Zipper’s to help you 
customize each individual map page for every conceivable combination. If you only 
need a slight timing adjustment at a specific RPM, consider using the Timing vs. Engine 
Speed Map page, as described in the next section.  

ADVANCE 
 
RETARD 

Select the 
Map page 
with your 
mouse to 

Draw Focus 
to the graph 

before 
making 

changes. 
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Timing Vs Engine Speed Map Page:  
 
This map page is for making quick adjustments to the ignition timing map.  It allows 
ignition timing adjustments in one-degree increments at every 256 RPM from the base 
setting of the installed map.  

 

 
 
Each point in the Timing vs. Engine Speed map page allows the tuner to adjust the 
spark timing for a particular RPM range. Moving a tuning block on this page will move 
every point on the corresponding RPM map page. For example, if you adjust the 2560 
RPM tuning block up one degree, ALL throttle position points on the 2560 RPM page 
will move up one block.  
 
If the knock is slight at a particular RPM, you may be able to remedy the situation by 
removing 1-2 degrees of timing at the Timing vs. Engine Speed page at the specific 
RPM it occurs. If the knock is more pronounced you may need to remove additional 
timing at specific throttle positions on the Timing Vs TPS pages at the specific RPM 
value you want to adjust then road test to review the changes.  
 
Attempt to adjust the timing on this composite page before altering the curves on 
the Timing vs. TPS @ RPM map pages.  
 

NOTE: Higher values of spark advance can improve response, efficiency, and 
power until you reach the point of detonation, which reduces power and can damage 
the engine.  

 
WARNING! BEWARE OF DETONATION! Severe pre-ignition or 
detonation can cause severe engine damage. If spark knock is heard or 
detonation is found by reading your spark plugs, immediately stop testing 
and retard the ignition timing at that RPM to remedy the situation. 

ADVANCE 
 
RETARD 
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Throttle 
Timing 
Display 

 
Each point 
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all 64 points 

on the 
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TPS @ Rpm 
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Rear Timing vs. TPS (Rear Cylinder Timing Correction): 

 

 
 

The Rear Timing vs. TPS page was added to eliminate any oddities between the front 
and rear cylinder operation. The ThunderMax AutoTune system individually monitors 
and alters the fuel setting for each cylinder for optimum operation. Now you have the 
ability to individually adjust the rear cylinder’s timing in comparison to the front cylinder 
as well. Due to the differences associated with the operation of the two cylinders, the 
rear cylinder adjustment allows you to modify the spark for optimum operating 
conditions.  
 
Modifying the Rear Timing vs. TPS page does not alter the Timing vs. TPS @ RPM 
map pages. This page only offsets the output of the main spark curves, but does not 
affect the front cylinder timing at all.  
 
This page will always start as a straight line at 0% Timing Adjustment. Any adjustments 
made to this page are recorded as % Timing Adjustment by Throttle position.  
 

 
Most cases will not require Rear cylinder adjustment, only make 
changes to this page if you’ve validated that your rear cylinder 
requires a timing adjustment on a dynamometer. No data = no 
adjustment. 
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Smoothing the Blocks: 
 

It is important to “smooth” the surrounding blocks to avoid abrupt changes in timing 
settings. The following figure shows a smooth spark curve adjustment change. Since 
the Timing vs. Engine Speed page has changed from a straight line showing the 
percentage of change to the generalized spark advance curve, it should be easier to 
smooth the blocks and see the changes that are being made to the Base Map timing 
curves. Remember you can always check each of the individual timing curves (Timing 
vs. TPS) map pages to see the effect that has occurred. If in doubt, test the new setup, 
record your findings, and make changes as needed.  

  

 
 

How to find Throttle Position of Detonation (Spark Knock or Pinging): 
 
If you are attempting to tune with or without the benefit of a load control dynamometer, 
you may find the following suggestion helpful.  Link to the module without starting the 
engine with the monitoring function enabled, open the Air/Fuel vs. TPS window and 
observe the red vertical bar indicating active throttle position.  Twisting the throttle 
through its range will move this vertical bar.  Using masking tape; wrap tape around the 
throttle grip, at the edge closest to the switch housing.  Apply another piece of tape to 
the switch housing (base) alongside of the grip tape.  Make a mark across both pieces 
of tape indicating the throttle position at idle. See the pictures on the next page for 
clarification.  
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Using the vertical bar as a guide, make marks on the grip tape even with the base idle 
mark at ¼, ½, ¾ and full throttle.  When you can identify the location of the throttle 
position and the associated RPM during a drivability issue, you will find it very easy to 
pinpoint and make adjustments to the areas that need help. The following pictures show 
an example of how to use tape to tell an approximate TPS where the detonation is 
taking place.  

 
WARNING:  ANY TUNING OPERATION INVOLVING 

ACTUAL OPERATION OF THE MOTORCYCLE ON PUBLIC STREETS 
OR HIGHWAYS IS DANGEROUS!  FULL ATTENTION TO TRAFFIC 
CONDITIONS SHOULD ALWAYS BE YOUR FIRST FOCUS ANYTIME 
YOU ARE OPERATING A MOTORCYCLE ON PUBLIC ROADS.  
INATTENTION TO CONDITIONS CAN LEAD TO ACCIDENTS AND 
PERSONAL INJURY INCLUDING DEATH.   

 

 
Closed Throttle – Marked “0” 

 
¾ Throttle – Marked “3” 
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Timing Troubleshooting: 
 
Here are a few common scenarios that have been seen several times by Product 
Support. The first thing you need to do before you adjust the base map is to verify you 
have selected the correct map. Selecting a map with incorrect parameters is usually the 
source for spark knock problems. Take the time to verify the best possible base map 
has been selected for your application.  
 
 

1.) If you have not experienced any spark knock or detonation problems, but 
pinging develops after your last fuel stop, do you need to adjust your 
timing? As long as spark knock has not been experienced before, continue 
operation of the motorcycle, and purchase fuel from a different source before 
making any changes to your map. 
 
It is common for gasoline to be blended differently in different regions of the 
country. Touring riders will experience this much more so than riders that stay 
in one region of the country.   

 
2.) If the gasoline has not made a difference in the operation of the motorcycle, 

check that your intake & exhaust seals are not leaking, your AutoTune system 
is turned on, as well as reading the spark plugs. If excessive oil is found on 
the plugs, you may have a head gasket leak. A head gasket leak can cause 
detonation by depleting the octane rating of the fuel, allowing a build up of 
gasoline in the combustion chamber, and igniting the rich mixture when the 
temperature reaches a high enough level to pre-ignite.  
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CUSTOMIZING FUEL TARGETS 

AIR FUEL RATIO VS TPS @ RPM PAGES, “AFR TARGET 
PAGES” 

 

 
 
The “AFR Target” pages are the most important pages in the software for managing 
a highly efficient, well tuned engine. It’s the AFR Target pages that allow you to make 
maximum power and maximum fuel economy at the same time. Since the throttle 
positions are drastically different between a maximum power scenario and a best MPG 
scenario, you can dial in each section independently, and achieve both. 
 
Simply put, these are the “AFR Target Pages” that the AutoTune system is working to 
achieve during Closed Loop Tuning. To explain the strategy, there are 32 target points 
of adjustments (throttle position) per map page, with a map page for every 256 RPM. 
Each base map has default values which you can change to improve fuel economy at 
cruising speeds or richen up for more power at the race track. The AutoTune system 
works to maintain these targets as all of the ambient conditions involved change.   
 
There are two options for setting the AFRs in your ThunderMax ECM.  
 

1.) The first technique, which is the preferred method, takes more time to setup, 
yet allows you to vary the AFR targets for different RPM and Throttle 
Positions. This allows you to fine tune the AFR for economy at light loads 
(leaner AFR during lower throttle positions) at the same time as tuning for 
peak power in high throttle positions (richer AFR during heavy load or 
acceleration). The pay off is worth the effort, for increased throttle response, 
maximum power, and excellent fuel economy can all be achieved 

LEANER 
 
RICHER 

Select the Map 
page with your 
mouse to Draw 

Focus to the 
window. 
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simultaneously. The end result will be a perfect balance of power and 
economy even as conditions change.  
 

 
2.) Another technique in setting up the AFR Targets, which is recommended for 

racing or other special applications, can be achieved very simply in the “Closed Loop 
Module Settings” window. The option of “AFR Override” allows you to set (1) specific 
AFR for the ThunderMax ECM to target at all points and conditions. This is discussed in 
the Closed Loop Module Settings section. This choice is most popular with racers or 
dynamometer tuning for Base Map generation or just simply tuning for maximum 
measured power output. Choosing this option will affect the warm-up AFR as well, 
which may adversely effect the operation of the motorcycle. 
 
Note: It will require several sessions for these targets to be achieved provided you 
operate the engine at these specific RPMs and throttle positions at operating 
temperature.   
  
AFR Target Tuning Aides: 
 
To simplify tuning the 32 Air/Fuel Ratio vs. TPS @ RPM map pages, “copy” and “paste” 
functions have been added to TMax Tuner. For example, if you modify your normal 
cruising RPM map page and are pleased with the results, you can now copy this curve 
and paste it into other RPM map pages. Select “Shift-Control-C” to copy the map page. 
Now scroll to the next map page and select “Shift-Control-V” to paste the copied RPM 
map page onto the new RPM map page. Select “F2” at any point to view the TMax 
Tuner Hot Keys. For example, start by modifying the 768 RPM Map Page, then paste 
that curve on all of the map pages up to the 3584 rpm page. 
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Section 5: Diagnostics 
and Troubleshooting 
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BASIC DIAGNOSTIC TIPS 
   
When trying to determine a problem with the motorcycle, it’s noteworthy that the bulk of 
all ECM returns to Zipper’s are not faulty ECMs; rather the wrong map was selected, 
maps were changed without learned offsets being cleared, a factory sensor has failed, 
or wiring to the sensors is unplugged or rubbed thru bare.  Every ThunderMax ECM is 
quality tested before the final packaging, which includes linking to the module and 
starting an actual engine. If you just installed the ECM and your engine won’t start, 
something is likely wrong with the installation (hardware or software) or something may 
be wrong with your motorcycle; reinstall your factory ECM to validate that the problem is 
on the motorcycle, not the ThunderMax ECM. The following is a quick guide on what to 
check when a problem occurs.   
 
There are a few basic steps that should be taken when attempting to troubleshoot 
problems encountered when using the ThunderMax EFI system. Before altering the 
base map in the ECM, inspect all of the components that were installed, altered or 
otherwise handled during the system installation. Loose connections, damaged wires, or 
worn / melted coverings can cause significant problems and are difficult to diagnose. A 
simple check of the wiring can save you enormous amounts of time troubleshooting if 
the culprit is wiring related.  
 
Confirm the I.D. number of the map installed in your ECM and make sure you are using 
the latest module firmware and software. Zipper’s receives support calls about 
performance problems regularly only to find out that the correct map was not loaded or 
the default test map was still installed in the module. Make certain that you’ve written 
the selected map to the ECM; simply loading it in TMax Tuner software does not 
write the map to the ECM.  
 
If you installed a ThunderMax ECM to solve an operational problem on your motorcycle, 
and the problem still exists after installing the ThunderMax ECM, it is likely that there is 
a problem with your motorcycle, not your ECM. If your motorcycle didn’t start or idle 
properly before installing the ThunderMax ECM and the problem still exists, 
please state this upfront with Zipper’s Product Support; clear information upfront 
will save you time. If the problem was pre-existing and the issues are stated clearly to 
Product Support, the chances of solving the issue quickly are dramatically increased.  
 
Create a monitor log. 
We suggest you bring the engine to normal operating temperature, review and log the 
values using the “Engine Monitors” & “Monitor Logging” functions of the software. 
These values are vital in troubleshooting a problem that may be keeping the engine 
from operating properly. With the Monitor Logging feature, you can log an operating 
session and email the data to Zipper’s Technical Support for review.  
 
If either AFR values are not displaying correctly (or at all) in the monitor gauges, there 
may be a problem with the following: 

  
(1) Damaged wiring on the closed loop system 
(2) Damaged Wiring or connector on the oxygen sensor 
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(3) An oxygen sensor is unplugged 
(4) An oxygen sensor is damaged or dirty 

 
To test that the oxygen sensors are active and properly working, turn the ignition on, yet 
do not start the engine. Link to the module & monitor the AFR of the Front and Rear 
cylinders using the Monitor Gauges. Read the AFR Values for the Front & Rear 
cylinders, without starting the engine. After approx. 10 seconds, the sensors should be 
calibrated. Once calibrated to the ambient air, the oxygen sensors should warm up to a 
value of 19.36 for each sensor in the AFR monitor gauge windows.  
 
If you cannot replicate the value of 19.36, your oxygen sensors are not calibrating 
correctly. This will cause corrupt data to influence the effectiveness of the 
ThunderMax Auto-Tune system in properly following the targets on the tuning 
pages. 
 
If steps 1-4 are found to be in good order, remove the sensors and inspect for soot build 
up. You can clean the sensors with a product like CRC brand "QD electronic cleaner" 
(Permatex® part# 24378) then reinstall sensors and re-perform tests.  
 
If the sensors now work correctly, or you have to replace them, you should trouble shoot 
to determine if the wrong map has been selected or the map pages need to be 
adjusted. Excessively rich AFRs during the warm up procedure, or at normal operating 
temperatures, will ultimately coat the sensors in soot (carbon). Once the sensors are 
dirty, they may not operate correctly, which can cause corrupt data to influence the 
Auto-Tune ECM’s tuning.  
 
If your motorcycle is operating properly, and the tune up begins degrading, it is highly 
likely that a mechanical issue is influencing the Auto-Tune system. This is actually a 
great warning system; for example, let’s assume that your intake seals start leaking. In 
a Closed Loop Auto-Tune system, the ECM will continue adding fuel to maintain the 
AFR targets. Eventually you will notice a loss in power, lower fuel economy, and a loss 
in idle stability.  
 
Since the Auto-Tune system is adding fuel for the additional air provided by the leak, the 
engine never gets a chance to over-heat or cause significant engine damage. Since this 
is a learning system, if you feel that the tune up is deteriorating, more than likely the 
system is over-correcting for a mechanical problem that must be fixed.  
 
 
 
Another issue that can create problems is corrosion on electrical connections, fuse 
spades and sockets or the ECM connector. Any or all of these conditions can create 
abnormal results that are difficult to replicate or reproduce when troubleshooting yet the 
remedy is a straight forward, removal of scale or corrosion to the contaminated area.  
 
When cleaning your motorcycle, you should never directly wash the ECM 
compartment or fuse panel with water! Excessive water can create a host of bizarre 
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technical problems. The ECM is designed to keep water out; however, with pressurized 
water it is possible to soak the factory wiring harness connector to ECM connection.    
 
If a problem occurs after filling up your motorcycle with gas, make certain that the gas 
isn’t the culprit before you change anything in the ThunderMax ECM. It is not 
uncommon for fuel blending to vary in different regions of the country.  
 
Another common scenario is related to old gas. If you start a new riding season with last 
season’s gas still in the tank, the first thing you need to do is drain the old gas and 
replace it with fresh gasoline. Due to the increasing amounts of alcohol in the gasoline 
that’s being refined and blended today, the shelf life has gone down on common 
gasoline. The alcohol separates from the gasoline and changes the properties of the 
gasoline. If you think you may be experiencing a problem related to old gas, change the 
gasoline before putting any additional time into it. Low octane fuels are not 
recommended for these engines, and will cause tuning issues if used.  
 
In addition you should always work from the Harley-Davidson® Electrical Diagnostic 
Manual. These manuals are model-specific and contain valuable information in 
troubleshooting issues with TBW equipped Touring model motorcycles. If the problem is 
not related to the ThunderMax ECM, you will need to refer to the service and diagnostic 
manuals for the specific model in question.  
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GENERAL PERFORMANCE PROBLEMS 
 
EFI equipped engines need the same basic elements to function properly as carbureted 
engines.  If you are experiencing a performance problem, first review all installation 
instructions and verify all steps were followed, then: 
   

• Electrical Issues - Check for loose battery cables or other loose electrical 
connections. Then check for a failed sensor / view the Diagnostic Trouble Codes.  

• Spark - Check the spark plugs wires to verify they are not rubbing thru a 
decorative cover on the motorcycle. Some aftermarket wires make leak 
excessive amounts of RFI causing problems with the proper operation of your 
motorcycle.  If the plugs are full of soot; make sure the correct map is loaded, If 
the motorcycle had an operational issue before installing the ThunderMax ECM, 
it is likely that there’s another problem on the motorcycle that needs to be solved 
before proceeding with tuning.  

• Air / Fuel Quality - Ensure the engine is receiving clean air and good fuel. If the 
fuel is from last season or has been varnishing for several months, drain, flush 
and start over with fresh fuel.  Do you have adequate fuel pressure? 

• Mechanical Issues - Check for a mechanical issues such as loose hardware on 
the throttle body, improper throttle blade setting, leaking intake manifold seals, 
fuel delivery problems (in-tank fuel filter and fuel line), injector problems, wiring, 
wet sumping, or poor ring seal.  

 



 

 143 

GENERAL INSTALLATION NOTES 
 
 

Engine Light: If the engine light illuminates at high temperature during operation of the 
motorcycle, the ThunderMax ECM is warning you that the cylinder head temperature 
has reached the temp alarm threshold. Adjust the setting for the temperature that the 
warning light illuminates with a default value of 350 degrees. Continued operation 
(without a cool down period) could cause severe engine damage! Read DTC when 
you observe a Check Engine light.  
 
DTE: A firmware release will be available in the spring of 2010 which will enable this 
function, until then the DTE function is inoperable.  
 
Low Fuel Light (Up to 2007 models) - The low fuel light will operate exactly the same 
whether you are using the ThunderMax ECM or the factory ECM. Our in house testing 
has found that the low fuel light does not activate at the same time on every tank. What 
this means is that the volume of fuel left in the tank when the low fuel light comes on, 
varies almost every time it is activated. This inconsistency is not related to the 
ThunderMax ECM or any other ECM on the market.  
 
 
  
Removing, Changing or Charging the Battery:  When installing the ECM for the first 
time, remove the fuse for the ECM before disconnecting or reconnecting the battery.  
Hot-swapping components could promote a premature failure, which could result in 
damage to the ECM. Don’t forget to re-initialize the module whenever you interrupt 12v 
power  

 
We recommend to always remove the ECM fuse before disconnecting or 
reconnecting the battery!  
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ABOUT THUNDERMAX 
 

The ThunderMax EFI is a complete, stand alone system with Wide Band AutoTune 
operation for all injected H-D model motorcycles. This high-resolution Alpha/N-based 
system is the most advanced engine management system available. The ThunderMax 
ECM is not a post-fuel devise, or a “signal modifier”, it is a complete factory ECM 
replacement.    
 
The ThunderMax EFI system is a joint development and distribution project between 
two industry leaders, Zipper's Performance Products and Thunder Heart 
Performance Corp.  Zipper's Performance Products is a leading developer and 
producer of engine kits and performance components for the H-D aftermarket industry.  
Thunder Heart Performance Corporation engineers, designs and manufactures high 
technology systems and components for original equipment and aftermarket 
applications in the motorcycle industry. 
  
Our companies are committed to developing and improving the best engine 
management and fuel injection products in the industry. Our staff is dedicated to 
customer support. 
  
The ThunderMax comes with a 3 year limited warranty.  
 
For additional information including ThunderMax Cams by Red Shift as well as software 
and instruction updates, please visit the ThunderMax website, www.Thunder-Max.com . 
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Section 6: Updates 
 
 
 
 
 

An Internet Connection is required for all updates.
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TMAX TUNER UPDATES OVERVIEW 
 

There are two methods of updating the software, firmware, and EFI Map library; through 
the TMax Tuner software’s update features, and through the ThunderMax website. 
Occasionally some customers have issues updating their software through the 
integrated TMax Tuner update functions; however it is rarely the fault of the TMax 
Tuner software. The main reason for problems is quite simple, for some reason, your 
computer is not allowed to send and receive automatic requests for information from an 
outside FTP server. Since this is a function that’s automatically contacting an FTP 
server for information, some networks or computers will deny the TMax Tuner request 
for data transfer before it’s even allowed to contact the FTP server.  
 
Key reasons for not being able to update through the integrated Update functions are as 
follows: 
 
 1.) Your network is highly secured and does not allow automatic requests for 
unknown FTP servers.  
 
 2.) Your computer has a security or firewall setting that is not allowing TMax 
Tuner to automatically send information to and receive from the ThunderMax FTP 
server.  
 
 3.) You are using your office computer that was setup by your professional IT 
department. Many of the updating problems that are seen by Product Support are 
related to “business” computers where the user (you) does not have administrator 
privileges, and many network features are locked out.  
 
These are simply problems that the TMax Tuner support staff cannot help you with, 
given the number of operating systems in use today, and the complexity of modern 
network security. If your computer is administered by your IT department, you need to 
make them aware of the problem, but only if they are ok with you having personal (non 
business related) programs installed on the computer. Otherwise, you will need to 
purchase your own computer, and your own internet connection, to take advantage of 
the automatic update functions. However, this is completely unnecessary! ALL updates 
are available through any web browser.  
 
If you are experiencing problems with the automatic update functions through the 
software, you are not out of luck! Simply go to the ThunderMax website; 
http://www.thunder-max.com and manually download the latest Software, Firmware, 
or Tuning Manual release. It is not worth the effort if you cannot get the update function 
to work and do not know enough about your computer or network to correct the 
problem. If you do not control the computer or network settings, you will never solve the 
problem on your own, and there’s nothing that the Product Support team can do to help.  
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UPDATING THE TMAX TUNER SOFTWARE 
 
To maintain the most current version of TMax Tuner, use the update function in the 
software. An Internet Connection is required for all updates. 

 
Select Configure > TMax Tuner Update to begin the update process, as shown below. 
 

 
 

The following window will appear: 
 

 
 

 
 
One of two windows will appear: 
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Follow the instructions provided by the TMax Tuner update windows to update your 
version of TMax Tuner. When complete, open TMax Tuner and select Help > About 

TMax Tuner… to check the version number that is currently installed on your computer.  

Software is 
up to date! 
 
No action 
required. 

New 
Software 
Available! 

 
Proceed 
Forward 
with the 
Update 
Process 
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UPDATING THE BASE MAP DEFINITIONS 
 
To ensure that you have the complete and up to date Base Map Library, select the 
“Check Internet for Updates” button on the “Base Map Name Encoding” window, as 
shown below.  

 

 
 
You must be connected to the internet to update the Base Map Definitions as well 
as retrieving any available new Base Maps. The TMax Tuner Installation CD does 
contain the base map library; however it is only as current as the CD itself.  
 
It is simply good practice to update the definition file when searching for a new Base 
Map file. Not only are new maps constantly being created, but the older Base Maps are 
updated occasionally as well. Once updated, you may proceed with selecting an 
appropriate Base Map for the current engine combination you are working with.  
 
If you are satisfied with the operation of your current Base Map, chances are a new 
Base Map will not make a significant difference to the operation of the motorcycle. 
Updated maps could contain spark curve or fuel management changes, or even 
different fuel economy strategies. 
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UPDATING THE FIRMWARE IN YOUR THUNDERMAX ECM 
 

You can update the firmware, if an update is available, through the TMax Tuner 
software. An Internet connection is required to download the Firmware. Once the 
firmware file is downloaded to your PC, you do not have to be connected to the internet 
to upload the new Firmware to the ThunderMax ECM. You must be linked to the 
ThunderMax ECM to update the firmware in the module. There are two stages in 
updating the Firmware in the ThunderMax ECM.  
 
 Stage 1: Check for an update, and download the latest Firmware onto your 

computer. 
 

 Stage 2: Link to the ThunderMax ECM and follow the prompts to upload the new 
Firmware to the ThunderMax module.  

 
Both stages are fully covered in the following pages. Both require that you are linked to 
the ThunderMax ECM. The latest software will automatically link and read the module 
map and settings when the upgrade is initiated.  
 
Stage 1: Downloading an Updated Firmware 
 
 
Select Configure > Firmware > Check for Firmware Upgrade to see if there is an 
updated Firmware available for your ThunderMax ECM.  
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If an updated firmware is available for your ThunderMax ECM, the following window will 
appear: 
 

 
 
 
 

If you select the “OK” button, the firmware download will begin. Once completed, the 
following window will appear.  
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Stage 2: Uploading a New Firmware Version into the ThunderMax 
ECM 
 
Note: Removal of the headlight fuse is optional during the firmware upgrade. This will 
prevent unnecessary battery draw during the upgrade process. The image below shows 
the location of the headlight fuse (circled in red) behind the left side panel. 
 

 
 

 
Link to the ThunderMax ECM.  

 
You must be linked to the ThunderMax ECM to perform any firmware upgrades. 
To upload the new Firmware to the ThunderMax ECM, select Configure > Firmware > 
Upgrade Module Firmware Now, as shown below.  
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The following notice with suggestions to complete the firmware upgrade will appear:  
 

 
 
  Once you have read this prompt and made any changes necessary to your PC, click 
ok and the prompt below will appear. 
 

 
 
TMax Tuner will automatically read the map from your ECM when the upgrade is 
initiated as shown below.  
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Select the most recent version of the firmware by date from the next window and then 
click the “Open” button.  

 

 
 

Once the file has been opened, the following window will appear titled “Module 
Detection.” Follow the prompts to continue the firmware upgrade.  
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When the module power is turned back on after 20 seconds the firmware download to 
the module will begin as shown by the progress bar below. This could take as long as 5 
minutes to complete. 

 

 
 
 

 
 
 
Once the transfer completes, the “Module Detection” window will appear again with a 
progress bar showing the initialization of the new firmware and time remaining count 
down to completion. 
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Once the initialization completes, the “Module Detection” window will appear again.  
 

 
 

Follow the instructions on the “Module Detection” window: 
1.) Turn off the Ignition Switch for 20 seconds. 
2.) Turn on the Ignition Switch. The message below will confirm “Firmware 

Upgrade Process Has Completed. 
 

 
 

The software will automatically re-write the “Module Maps and Settings” to complete 
the upgrade process.   
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The Firmware is now upgraded in your ThunderMax ECM. To confirm the firmware 
version on your ThunderMax ECM, simply open TMax Tuner, Link to the ECM, and 
select Help > About TMaxI Tuner as shown below. The “ThunderMax” window that 
pops up will display the current software and firmware versions. You must remain linked 
to view the firmware version. 
 
 

 
 
 
 
          

 



 

 158 

GLOSSARY OF TERMS USED 
 

Accel Fuel – Factor of fuel enrichment during rapid throttle movement. 
 
AFR (Air Fuel Ratio) – Percentage of air and fuel as measured from a single engine 
cycle. Example an AFR of 14: 1 = 14 parts of air per 1 part of fuel by weight.   
 
AFR Correction – Percentage of additional or reduced fuel to the base map at a 
specific operating condition. 
 
AFR Override – Allows a single AFR variance from the map target AFR settings on 
each closed loop map page. 
 
Auto-Tune – A feature of the ThunderMax ECM, allowing the use of closed loop feed 
back to make lasting adjustments to the base fuel map. These adjustments may be 
needed due to degradation of fuel components, manufacturing tolerances in the throttle 
body, IAC motor, TPS, injectors, or any other component variations.  
 
Barometric Pressure – The measured atmospheric pressure at the ECM, this is a 
variable factor relative to absolute atmospheric pressure, and ultimately effects the AFR 
in your engine.  
 
Base Ignition Timing – This displays the calculated ignition timing from the base map 
before corrections are applied. 
 
Base Map – A set of curves that determine the amount of fuel and ignition timing 
required for each operating condition, for one engine configuration. 
 
Base Map Definitions – The Base Map Definitions are the strings of data that display 
the parts used in each Base Map File. This is updateable with a high speed internet 
connection. The update will reveal any new Base Maps added to the Base Map Library 
by Zipper’s.  
  
Basic Settings - A window used to observe / change the basic module settings such as 
Idle RPM, Speedometer Calibration and IAC learning offsets, etc.   
 
CL (Closed Loop) – Meaning the use of feedback or reference of set point value to 
adjust Offsets to adjust the fueling output. 
 
CL Corr Front – Front cylinder percentage Adjustment Pre & Post Auto Tune  
  
CL Corr Rear –   Rear cylinder percentage Adjustment Pre & Post Auto Tune  
 
CL Status – A value which can be helpful with tech support to diagnose a problem 
related to the closed loop feedback system.   
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Closed Loop Processing – The use of a feedback sensor (oxygen sensor) to correct 
fuel delivery based on past air/fuel ratio readings.     
 
CLP Offset – The deviation of fueling values from the base map as a result of Auto tune 
corrections.  
 
Cranking Fuelflow – % of fuel supplied during engine startup mode. 
 
Crank Position Sensor – Determines the precise location and speed of the crank 
shaft.  
 
DTC Warnings – Diagnostic Troubleshooting Code Warnings 
 
ECM – Electronic Control Module (or Engine Control Module or Electronic Control Unit 
(ECU) –  
 
EFI – Electronic Fuel Injection 
 
EGO –Exhaust Gas Oxygen (the oxygen content of exhaust gases) 
 
 EGO Front – Front cylinder real time Exhaust Gas Oxygen reading  
 
 EGO Rear –  Rear cylinder real time Exhaust Gas Oxygen reading  
 
 EGO Target – The desired target as per map settings 
 
Engine Monitor Gauge – A display window selected from the monitor page  
 
Final Drive Ratio – The option of “Final Drive Ratio” is only used on motorcycles with a 
6th Gear Indicator light.   
 
Firmware – The internal program which directs the functions of the ECM for fuel 
control, spark control etc. The Firmware is updateable with a high speed internet 
connection. 
 
Normal Operating Temperature – Cylinder head temperature between 240-285 
degrees Fahrenheit.  
 
Gear 6 Min Tps – Smallest value of throttle position that will allow 6th gear display, this 
setting is only used on 2007 and newer motorcycles.   
 
 
TAC Home Position – A value which is used to increase or decrease the amount of by-
pass air ffom the throttle blade, used during the starting function only. 
 
  
Idle Speed – The target in the software for desired engine speed at idle when at normal 
operating temperature.  
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Ignition Timing – A variable point at which ignition spark occurs, measured by degrees 
of advance or retard relative to top dead center position of the piston.  
 
Initial Fuel Pulse – An adjustable setting that primes the cylinders for optimum starting 
time. This only occurs one time per ignition start cycle. 

 
Initialization (Module) –The process which calibrates the TAC position to the module.   
 
Injector Duty Cycle – Percentage of time the injector is powered by the ECM per 
combustion stroke.  
 
Injector Size Compensation- Used to apply a fueling compensation to ALL fueling 
maps based on the ratio of the “Map Injector Size” versus the “New Injector Size”. 
 
Link –A term referring to the communication between the software and the module.  
 
Load Control Dynamometer – A modern Load Control “dyno” has an electronically 
controlled brake or loading devise added to allow tuning at specific RPM targets. This is 
the ideal setup for tuning EFI engines.  
 
Learned Fuel Adjustments – Offsets that have been learned by the ECM to correct the 
AFR at particular RPM and Throttle Positions.  
 
MAP sensor – A Manifold Air Pressure sensor is used in forced induction applications. 
 
NADS Nitrous – Nitrous Assist Dry System – An electronic “Dry” nitrous system that 
uses the ThunderMax ECM to add fuel like a Wet system. This is a plug and play add-
on to the ThunderMax ECM.  
 
Narrow-Band Oxygen Sensor – An oxygen sensor used to measure the amount of 
unburned oxygen in the exhaust stream of an operating engine. The term narrow band 
refers to the small range of AFRs that the sensor can report to the ECM.  A factory 
sensor is a narrow band, typically a 1, 3 or 4 wire oxygen sensor.  
 
Oxygen Sensor – An electronic sensor that measures the proportion of (O2) in gas 
being analyzed. 
 
Rear Trim – Rear Trim is the percentage of fuel being trimmed from the rear cylinder 
injector’s pulse width to match the front and rear cylinder AFRs. 
 
Rev Limit – A “Basic Settings” value which limits the engine rpm. Please consult the 
manufacturer of your engine to find the maximum RPM recommended. This is meant to 
be a safeguard against potential damage caused by over-revving the engine beyond its 
mechanical capabilities.   
 
Session (Tuning) – Also known as a “Key Cycle Event”. Every time the ignition switch 
is powered off, then powered on again, a new tuning session begins.  
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TMax Tuner Update – Allows user to check for updates, and when available, update 
the TMax Tuner software through a high speed connection. 
 
Speedometer Calibration – The Speedo Calibration is a number that is used by the 
ECM to determine the vehicle’s speed. This value is a function of the vehicle 
transmission, rear pulley, tire diameter, etc.  
 
Stoichiometric Air-Fuel Ratio (Stoichiometry) – This is the Ideal balance of reactants 
and products for the chemical equation associated with the operation of combustion. 
For gasoline applications, a stoichiometric mixture is found to have an air-fuel ratio 
(AFR) of 14.7:1, or 6.8% Fuel.  
 
Tip Angle – Also known as Bank Angle, refers to a sensor which detects if the bike is 
tipped or banked to one side more than 45 degrees for longer than one second. Power 
is interrupted to Turn Signals, Starter Motor, Ignition Controller, Fuel Pump and Coil 
when this sensor is tripped. 
 
TMax Tuner Map Database – The TMax Tuner Map Database is a database of pre-
made, professionally tuned Base Maps that currently span from a 96” stock engine to a 
110” SE engine.  
 
TMCC – Refers to the TMax Control Center, the one stop window for monitoring the 
most critical system data. 
 
TPS (Raw) - An unfiltered voltage signal which can assist with adjusting throttle blade 
settings. 
 
TPS (Throttle Position Sensor) – A potentiometer attached to the throttle shaft which 
communicates throttle position to the ECM using a voltage signal. 
 
Tuning Map Tree – The Tuning Map Tree is located in the upper left part of the TMax 
Tuner Layout. This is where all of the individual tuning maps and module configuration 
options are located.  
 
Wide-Band Oxygen Sensor – A type of sensor which is capable of precisely 
measuring exact air/fuel ratios. 
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APPENDIX 
 

Drop Down Menus 
 
The following section is to be used as a quick reference when using TMax Tuner. All of 
the menus are dissected and a quick explanation of each option is given which 
references the section in this manual that fully covers the topic.  
 

Appendix Index: 
 

A1: File 
A2: EFI Maps 

A3: Map Editing Tools 
A4: Tools 

A5: Configure 
A6: Monitoring 

A7: Window 
A8: Help 

A9: TMax Control Center  
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Appendix A1: File 
 

 
 
The “File” Menu contains the standard menu options of New, Open, Save and 
Exit. In addition to the standard options, communication to the ECM can be 
performed through this menu with the Read / Write functions.  
 
• The “New” option will allow you to open an “Untitled” Base Map File. Although 

you cannot create a new Base Map with the software, the “Untitled” Base Map 
is necessary when linking to a ThunderMax ECM with an unknown Base Map 
File loaded onto it.  

 
• The “Open” option allows you to open a Base Map File, if you already know 

the name of the file that you need. When selected, the Base Map folder on your 
computer will be displayed, with all of the current Base Maps listed. If you do 
not know which Base Map file you need, please see the EFI Maps section in 
Appendix A2.  

 
• The “Close” option will close the Base Map file that is currently opened in 

TMax Tuner. By default, if changes have been made, TMax Tuner will ask if 
you want to save your changes.  

 
• The “Save” option saves the map that is currently displayed in TMax Tuner, 

along with changes made to the Base Map File, using the current file name.  
 
• The “Save As…” option allows you to save your tuning work to your computer 

under a new name. The ThunderMax ECM records any changes made 
instantly, but it is a good idea to save your modified Base Map File under a 
new name for easy reference and to prevent overwriting the previous version.  
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• The “History” function of TMax Tuner will always be displayed between the 
“Save As…” option and the “READ Module Maps and Settings” option. This 
section will display the names of the last four Base Map Files that have been 
opened in this particular installation of TMax Tuner. 

 
• The “READ Module Maps and Settings” option is used for synchronizing TMax 

Tuner to the ThunderMax ECM’s Base Map File. This particular function will 
read the ECM’s Base Map and display it in TMax Tuner.  

 
• The “WRITE Module Maps and Settings” option is also used for synchronizing 

TMax Tuner with the ThunderMax ECM. However, this option will write the map 
displayed in TMax Tuner to the ThunderMax ECM.  
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Appendix A2: EFI Maps 
 

 
 
 
The “EFI Maps” Menu contains all of the functions that you need to find a Base 
Map File for your application.  
 
• The “EFI Map Listings / Definitions” option opens the Base Map Definitions 

window. This provides you with full access to browsing the Base Map File 
Database, loading a chosen Base Map into TMax Tuner, as well as an option to 
update your current Base Map File Definitions.  

 
• The “Map Notes” option will display a window called Map Notes. If you haven’t 

used this feature before, it will load as a blank window. Please use this 
window to save any notes on the changes that have been made from the Base 
Map File.   

 
 
 
 
 
 
 
 



 

 166 

Appendix A3: Map Editing 
 

 
 
The “Map Editing” menu allows you to use the learning functions of the 
ThunderMax ECM to quickly improve the operation of your motorcycle.  
 
• The Read “Learned Fuel Adjustments (CLP OFFSET)”) function retrieves all of 

the fuel offsets from the ThunderMax ECM and synchronizes the ECM to the 
map being viewed in TMax Tuner. This is necessary for viewing offsets, as 
well as using the Auto-Tuned Points Analyzer. 

 
• The AutoMap (Write “Learned Fuel Adjustments (CLP OFFSET)” option allows 

you to set the previously learned fuel points as the Module Map File. This will 
update your Module Map and allow you to refresh-expand the AutoTune 
learning ranges.   

 
• Clear “Learned Fuel Adjustments (CLP OFFSET)”” will erase ALL learned 

offsets that the AutoTune system has created.  
 
• The “READ Module Maps and Settings” option is used for synchronizing TMax 

Tuner to the ThunderMax ECM’s Base Map File. This particular function will 
read the ECM’s Base Map and display it in TMax Tuner.  

 
• The “WRITE Module Maps and Settings” option is also used for synchronizing 

TMax Tuner with the ThunderMax ECM. However, this option will write the map 
displayed in TMax Tuner to the ThunderMax ECM. 

 
• The “Undo Edits” option returns any learned map points back to the original 

map point, as shown by yellow tracers. Simply put, the tuning blocks will 
return to the yellow tracers.  
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• The “Reset Undo (yellow markers)” option is used for altering the Base Map 
file in the ThunderMax ECM. This option lets you set the learned and adjusted 
map tuning blocks as the Module Map File points.  Simply put, the yellow 
tracers are reset to reflect the ECM’s adjustments.  
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Appendix A4: Tools 
 

 
 
The “Tools” menu is primarily used when a change occurs to the engine 
combination that the ThunderMax ECM has already been used with.  
 
• The “Injector Size Compensation” option opens up a window that will ask for 

the size of the existing injector (used in the map) and the new injector. This 
feature will determine the percentage fuel change between the two injectors, 
and adjust ALL of the map points by this factor.   

 
• The Global Percent Fuel Adjustment allows you to raise or lower ALL fuel 

points in the entire map.  
 
• The Auto-Tuned Points Analyzer now serves as a link to the TMax Control 

Center .  
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Appendix A5: Configure 
 

 
 
 
The “Configure” Menu contains options pertaining to the settings of the 
ThunderMax ECM as well as TMax Tuner software.  
 
• The “Firmware” option allows you to check for new firmware and upgrade the 

firmware that is used in the ThunderMax ECM.  
 
• The Product Configuration option allows you to switch between Tuner and 

Tuner Plus software.   
•  
• The “Authorize Product” option is only used when upgrading from Tuner 

software to Tuner Plus. This will only be used by tuners who have 
successfully been approved by Zipper’s to use the Tuner Plus software. The 
Tuner Plus Software is used in the creation of new Base Maps. 

 
• The “Closed Loop MODULE Settings…” option will open a window that gives 

you several choices for settings of the Closed Loop system on your 
application.  

 
• The “MODULE Settings” option allows you to activate and control the NADS 

nitrous system and any supercharger system. These settings allow you to 
make changes to account for these power adders. The “TMax Software 
Update” option allows you to check and see if a newer version of TMax Tuner 
is available. You will need an internet connection to check for updates.  

 
• The “TMax Tuner Update” option; this software package is constantly being 

refined and upgraded, no matter what version you may have purchased, a free 
upgrade is always available as the software improves.   
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Appendix A6: Monitoring 
 

 
 
TMax Tuner Monitoring is used while performing live tuning, to keep a watchful 
eye on the vital engine data. Also the monitoring function allows you to 
customize your gauge layout, and record an operating session.  
 
• The “Monitor Setup…” option allows you to choose which monitored values 

you want displayed on the main Monitor View page.  
 
 
• The “Show Gauges” options allows you to toggle the visibility of the 

customized Monitor Gauges. 
 
• The “Monitor Logging” option allows TMax Tuner to record a tuning or 

operating session for later review or replaying. Very useful when a tuning 
issue arises.  

 
• The “Monitor Replay” option allows you to open recorded Monitor Logs for 

review. This is a great tuning aide when troubleshooting operating issues.  
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Appendix A7: Window  
 

 
 
The Window menu allows you to maximize the Tuning Map window and toggle 
with the monitor gauges for on-top view.  
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Appendix A8: TMax Control Center   
 

 
 

• The “TMax Control Center” is an easy to use, one stop resource center for 
software navigation of the most commonly used ThunderMax functions.  
Located in the top tool bar of your Smart Link software, TMax Control Center 
allows easy access to: 

• Progress of the Auto-Tune system fuel adjustments  
• IAC Calibration integrity  
• Engine RPM and Temperature Logs  
• Engine Diagnostic Codes  
• Auto-Tune Settings 
• Basic Module Settings (Basic Settings)  
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Appendix A9: Help 
 

  
 
The Help menu has seven options which all relate to technical support for the 
ThunderMax ECM and TMax Tuner.  
 
• The ThunderMax Tuning Manual (pdf) is now easier to find; simply select this 

option and the latest Full Tuning Manual will open in Adobe Reader.  
 
• The “USBSER Driver Installation Document” provides detailed instructions for 

installing the driver for USB communication between the ECM and your PC.  
 
• The “Online Help Documents” is a link that takes you directly to the 

Instructions section of the ThunderMax website. Any additional support 
documents can be downloaded from this site.  

 
• Simply select “ThunderMax Website” and now your default web browser will 

open directly to the ThunderMax site. The website contains all of the 
supporting documents, as well as information about additional ThunderMax 
products, Nitrous kits, larger throttle bodies, ThunderMax Cams by Red Shift. 

 
• The “Prepare and Send, Module Data Email” is a new feature that packages 

your Base Map file, the Learned Fuel and creates and sends an email to the 
ThunderMax Product Support Team with your information. 

 
• The “Create and Send, Monitor Log Email” feature will save a monitor log run, 

and automatically email it to the ThunderMax Product Support team.  
 
• The “About TMax Tuner…” option will display the current TMax Tuner version 

number, as well as the current ThunderMax ECM Firmware version when 
linked to a module. 

 


